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1 Introduction

The VI-Suite is a free and open-source add-on to the 3D modelling and animation package Blender,
that provides a set of tools for the analysis of environmental factors within and around buildings. It
uses Blender’s node system (figure 1) to provide a user interface that allows quick and custom analyses
to be created. As of VI-Suite version 0.7, nodes exist for GIS height map import, sun path analysis,
wind rose display, shadow and sky view factor studies, embodied carbon, lighting metric prediction,
energy performance with advanced airflow network creation, whole-life carbon and flow analysis with
computational fluid dynamics. The lighting, energy and flow analyses are achieved with the four main
VI-Suite components: LiVi, which acts as a pre/post-processor for the Radiance lighting simulation
suite (version 5.2); EnVi, which does the same for the EnergyPlus thermal simulation engine (version
22.1); FloVi, which interfaces with the OpenFOAM CFD suite from OpenFOAM.org (version 11); AuVi,
which interfaces to the pyroomacoustics Python libraries (0.7.4).

Figure 1: Blender nodes

2 Installation

The VI-Suite is an add-on for Blender and can be downloaded from the VI-Suite blog site (https://b-
logs.brighton.ac.uk/visuite/download/). The zip files available there contain all the Radiance and En-
ergyPlus files required to run analyses with the VI-Suite. OpenFOAM binaries are however not in-
cluded, and must be installed independently by the user. Version 11 of OpenFOAM provided by Open-
FOAM.org (https://openfoam.org/) is required. On Linux, these binaries can usually be installed by
the OS’s package management system. On OS X and Windows, Docker Desktop should be installed
and a Docker installation of the dicehub/openfoam:11 image is required. Docker must be running in
the background when doing a FloVi analysis. The image below shows shows Docker desktop running
with the required Docker image.
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Figure 2: Docker desktop running with dicehub/openfoam:11

VI-Suite v0.7 is compatible with the latest LTS release of Blender (currently 4.2). The download
page of the VI-Suite blog (https://blogs.brighton.ac.uk/visuite/download/) has links to the relevant
downloads. For Windows and OS X, Blender can be downloaded from https://www.blender.org/-
download/lts/. On Linux, the system’s package manager should be used to install Blender along with
PySide6, Matplotlib, Kivi and Netgen and pyroomacoustics as the zip file from Blender.org will not
work with FloVi (see section 2.1). Once Blender has been installed, run Blender and go to the ’Edit’ -
’Preferences’ menu and in the preferences window (figure 3) click in the ’Add-ons’ tab on the left and
then ’Install’ at the top. Navigate to the downloaded zip file, select it and the VI-Suite option should ap-
pear in the list of add-ons. Click on the little box on the left to activate the VI-Suite. This step can take
some time, and will require an internet connection, as the VI-Suite downloads and installs required
Python libraries.

Once activated, the drop-down arrow to the left of the activation box displays a section for the
setting of some overall options. These are:

◦ Radiance bin - sets a custom directory for Radiance binaries. This is not required as the necessary
Radiance binaries are included with the VI-Suite but this option can provide the full suite of
Radiance binaries if desired.

◦ Radiance lib - sets a custom directory for Radiance libraries. This is not required as the necessary
Radiance libraries are included with the VI-Suite but this option can provide the full suite of
Radiance libraries if desired.

◦ EnergyPlus bin - sets a custom directory for EnergyPlus. This is not required as the necessary
EnergyPlus binaries are included with the VI-Suite but for advanced analysis with EnergyPlus’
EMS this should to point to a complete local install of EnergyPlus to make available the required
Python libraries.

◦ EnergyPlus weather - sets the directory for EnergyPlus EPW weather files. This is not strictly
necessary as the VI-Suite comes with a couple of included EPW files but the user will generally
want to set this to simulate with their own climate files.
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◦ Database - sets the directory for user databases of materials. constructions, embodied carbon
and PV modules. This should be set to prevent VI-Suite updates overwriting the built-in data-
bases and any user made additions to them.

Addons tab

Install button
Activation button

Addon expander

VI-Suite preferences

Figure 3: Blender addon preferences window

2.1 Linux system installations

As Netgen does not seem to work with the portable linux zip file of Blender available from Blender.org,
and therefore possibly not with other portable installations such as snap and flatpak, it may be neces-
sary to install a system version of Blender and all the VI-Suite dependencies for full functionality. This
section details how to do that on Arch linux, as that is the variant of linux I run. If you figure out how to
do it on other flavours of linux, let me know at https://groups.google.com/g/vi-suite and I will expand
this section.

2.1.1 Arch linux

Arch has a nice package management system called pacman, and most packages required can be in-
stalled via pacman. The packages required are:

◦ blender

◦ pyside6

◦ python-matplotlib

◦ python-kivy

All these can be installed with the sudo pacman -S package_name terminal command.
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In addition, python-pyroomacoustics, netgen-git and openfoam-org need to be installed from
the Arch User Repository (AUR) https://aur.archlinux.org/. The PKGBUILD file for netgen-git can be
downloaded from https://aur.archlinux.org/cgit/aur.git/snapshot/netgen-git.tar.gz, python-pyroomacoustics
from https://aur.archlinux.org/cgit/aur.git/snapshot/python-pyroomacoustics.tar.gz and openfoam-
org from https://aur.archlinux.org/cgit/aur.git/snapshot/openfoam.tar.gz. The folders within these
archives should be decompressed to your file system. Navigate to each created folder with the ter-
minal and run makepkg -fsri to build and install them.

There are also helper applications to automate the installation of AUR packages; I use pikaur ht-
tps://github.com/actionless/pikaur. With pikaur, for example, running the following commands will
install netgen and OpenFOAM:

◦ pikaur -S netgen-git

◦ pikaur -S openfoam-org

Dr Ryan Southall 7 School of Architecture, Technology & Engineering

https://aur.archlinux.org/
https://aur.archlinux.org/cgit/aur.git/snapshot/netgen-git.tar.gz
https://aur.archlinux.org/cgit/aur.git/snapshot/python-pyroomacoustics.tar.gz
https://aur.archlinux.org/cgit/aur.git/snapshot/openfoam.tar.gz
https://github.com/actionless/pikaur
https://github.com/actionless/pikaur


VI-Suite v0.7 3 Configuration

3 Configuration

Running Blender launches the main Blender interface, which should look similar to the one shown in
figure 4. The main interface area is the 3D viewport where the default cube, lamp and camera can be
seen. Below this is the animation timeline, on the top right is the project outliner that contains a list of
everything in the scene, and bottom right are the properties panels where many of Blender’s options
and functions reside. At the side of the properties panel window are tabs to control which panel is vis-
ible. The main panels used in the VI-Suite are the "Material" and "Object" properties panels. Detailed
instructions on how to use Blender are beyond the scope of this document, but there are excellent and
free beginners tutorials available online.

VI-Suite node 
editors

Area change menu

VI-Suite display tab

Object properties tab

Outliner

VI-Suite Object 
properties panel

Material properties tab

Figure 4: Blender interface

Once the VI-Suite has been activated it creates VI-Suite specific Object and Material properties
panels as well as three node editor windows: “VI-Suite Nodes”, “EnVi Network” and “EnVi Material”.
Blender’s interface areas generally sit side-by-side and any window area can be turned into any other
window area type by selecting the type from the drop-down menu at the left-hand side of an area’s
header bar, which sits either at the bottom or the top of each interface area. For example, the timeline
can be turned into the VI-Suite Nodes editor by selecting “VI-Suite Nodes” in the drop-down menu at
the very left of the timeline header (figure 4).
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4 The VI-Suite Interface

4.1 Changes from v0.6

If you are familiar with the interface of v0.6 there are no significant changes to the VI-Suite UI ele-
ments. The VI-Suite controls Blender object properties in the object properties panel (section 4.10.1),
Blender material properties in the material properties panel (section 4.10.2), and 3D visualisation in
the 3D Viewport sidebar (section 4.10.3). The bulk of the VI-Suite UI is however contained in nodes
that the user can manipulate within the three VI-Suite specific node editor windows: “VI-Suite Nodes”
(section 4.9.1), “EnVi Network” (section 4.9.3) and “EnVi Material” (section 4.9.2).

4.2 Kivy Windows

The VI-Suite uses Kivy (https://kivy.org/) to present feedback on running simulations to the user. Any
simulation that takes a noticeable amount of time (SVF, shadow mapping, LiVi, EnVi and FloVi simu-
lations) will open a Kivy window which will display time to simulation completion (SVF, shadow map-
ping, LiVi and EnVi), and error residuals (FloVi). All Kivy windows also present a cancel button to
terminate a running simulation.

4.3 Tooltips

Most node and UI options created by the VI-Suite have tooltips. These can be enabled in Blender by
going to ’Edit > Preferences > Interface, and turning on Python Tooltips. Hovering over the option in
the Blender interface with the mouse will now offer a small text description of the option.

4.4 Mesh indices

It can be useful to visualise the indices of mesh elements within a Blender mesh object, especially for
EnVi analysis where face index is used to identify the connection of boundary faces across different
objects. To turn mesh index visualisation on go to ’Edit > Preferences > Interface’ and turn on “De-
veloper Extras”. Mesh indices can now be visualised in object edit mode by turning on “Indices” in the
viewport Overlays panel. To view face indices, face select mode must be active and the desired faces
selected.

4.5 Collections

Collections are used in Blender 3.6 to organise geometry, which can be viewed and manipulated in the
Outliner window (figure 4). This presents some opportunities for the VI-Suite but also some additional
complexity. Collections are created automatically in the VI-Suite to organise generated geometry e.g.
the “LiVi Results” collection stores LiVi results geometry, “SunPath” stores VI-Suite sun paths etc.

When a user creates new geometry it will automatically go into the current active collection, and
this can cause problems if geometry is created into one of these VI-Suite defined collections, as these
collections are sometimes cleared out to make room for new VI-Suite objects when exporting or sim-
ulating. To avoid this make sure that, in general, user geometry is not resident in these VI-Suite col-
lections when VI-Suite analyses are undertaken. Manipulation of the location of objects relative to
collections can be quickly achieved within the Outliner window (4).

4.6 File structure

The VI-Suite requires a folder location on the host computer to store files generated during analyses.
This folder is generated automatically when relevant analyses are conducted, and is given the same
name as the Blender file, and in the same location. For example, if the current Blender file is called
“First_project.blend” and is saved to the Desktop, then when required a folder will be created on the
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Desktop called “First_project”. In the remainder of this document this folder is referred to as the project
directory. Before any analysis can be conducted with the VI-Suite, the Blender file should be saved to
identify the name and location for this project directory.

4.7 VI-Suite log file

As simulation steps are conducted, relevant information is written out to the “vi-suite-log” file in
Blender’s text editor. Information written here will include the commands being run, some results
data and error messages. If something is not working as expected checking this log file is the first step
to debugging. Running Blender from a terminal can also provide additional debugging data.

4.8 Parametric analysis with Blender frames

As Blender is in part an animation suite, it incorporates the concept of animation frames and most
elements contained within a Blender scene e.g. geometry, materiality etc., can be animated i.e. their
properties can be set to change across animation frames. The VI-Suite uses this concept of frames to
provide parametric analysis, and refers to the parametric scenarios simulated also as frames.

4.9 The Node System

Figure 5: VI-Suite nodes menu on the right to switch between all VI-Suite node trees

As the VI-Suite generally presents a node based interface to the user, node editor windows are re-
quired to host the node trees. Three types of node editor window are created as part of the VI-Suite,
and can be selected from the drop-down menu on the left of each Blender area’s header bar. These
three node editors are: “VI-Suite Nodes”, to provide overall control of VI-Suite simulations; “EnVi Net-
work” nodes to provide the interconnections between zones and zone properties for EnVi simulations;
“EnVi Material” nodes to designate construction layers in EnVi Simulations.

Within each of these node editor windows there is a tab (figure 5) in the right hand sidebar (’n’ key
toggles visibility) that allows you to switch between different node editors and node trees.

Nodes and the relationship between nodes, called node trees, are created by the user, or automat-
ically by the VI-Suite, in these node editor windows. VI-Suite nodes can sometimes be coloured red
and this generally means one of three things:

◦ The node contains a button which has not yet been pressed but needs to be.
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◦ The options selected within the node are different to the selected options when the button was
last pressed.

◦ The options selected within the node are invalid within the context of the other nodes the node
is connected to.

The node colour will revert to the general Blender theme colour if none of the above conditions are
true and the node, in its current state, is valid as a simulation component.

Links between nodes are also generally controlled by the VI-Suite so that only valid links can be
made. If a link is attempted between two node sockets that are incompatible, the link will immediately
disappear. Sockets are generally coloured to show which can be connected (red to red, yellow to yellow
etc).

4.9.1 VI-Suite Nodes

Nodes created within a VI-Suite Nodes window specify the the main building blocks to create simu-
lations. An initial VI-Suite Node tree has to be created manually by clicking on the “New” button in
the middle of the header bar of the VI-Suite Nodes interface area. Only one VI-Suite node tree should
be created. Once a node tree has been created nodes can be added with the “Add” menu in the node
window header bar. There are six node categories:

◦ “Input nodes” that import data into the VI-Suite

◦ “Process nodes” that export Blender information to a format that can be used for analysis

◦ “Analysis nodes” that run analyses

◦ “Display nodes” that display the results of analyses.

◦ “Image nodes” that process images.

◦ “Edit nodes” that can manipulate data

◦ “Output nodes” that can export data for third-party analysis.

Node tree creation 
and selection

Figure 6: VI-Suite Nodes editor

If switching a window area from a VI-Suite node tree to something else e.g. an animation timeline
window, and then switching back again, the previously active node tree may not display. The user
will then need to select the node tree from the drop down menu in the middle of the VI-Suite Nodes
window header bar or from the VI-Suite node menu (figure 6).
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4.9.2 EnVi Material Nodes

If conducting an EnergyPlus simulation with EnVi, building construction specifications are required.
These are created with EnVi Material nodes. An EnVi Material node tree is created by clicking on the
“Create EnVi Nodes” button in Blender’s material properties panel. This node tree is linked to the
Blender material for which it was created, so selecting the material will show the linked node tree
in the EnVi Material interface area. An EnVi Material node tree can also be can also be selected by
clicking on the EnVi material in the VI-Suite node menu in the sidebar of any VI-Suite related node
window (figure 5).

In the “Add” menu of an EnVi Material node tree are the following categories:

◦ Type node - Type of construction (currently just EnVi Construction)

◦ Layer node - Type of material: opaque, transparent and gas (latter two are mainly for window
constructions)

◦ Shading node - Shading layer, blind layer, screen layer, switchable layer, shading control node
(experimental nodes for advanced shading)

◦ Schedule node - sets an EnergyPlus schedule

◦ PV node - Photovoltaic and Photovoltaic generator nodes

When creating an EnVi Material node tree with the “Create EnVi Nodes” button in the material panel
a single node is created by default: an EnVi Construction node.

4.9.3 EnVi Network nodes

Nodes created within an EnVi Network node editor window control the zones and the relationship
between zones for EnVi simulations. An EnVi Network node tree is created automatically when ex-
porting Blender geometry with an EnVi Geometry (section 31) node, and an EnVi Zone node is created
here for each thermal zone to be simulated. A single EnVi AFN node (section 34) is also created here.

In the “Add” menu of an “EnVi Material” node tree are the following categories:

◦ Zone nodes - defines EnergyPlus zone and associated parameters

◦ Schedule nodes - defines EnergyPlus schedules

◦ Airflow nodes - defines airflow connections between zones and external air conditions

◦ EMS nodes - defines ERL program elements for runtime control of EnergyPlus simulations.

An EnVi Network node tree is created automatically when a valid EnVi geometry export is conducted
within the VI-Suite Nodes tree, and should not be created by the user.
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4.10 VI-Suite panels

In addition to node editor windows, the VI-Suite creates some panels for the specification of VI-Suite
specific object and material properties.

4.10.1 Object properties panel

Figure 7: VI-Suite Object definition tab

The object properties panel is one of the prop-
erties panels situated by default in the lower
right of the Blender interface (figure 4). The ob-
ject properties panel defines Blender properties
at the object level. Within this panel there is
a sub-panel called “VI-Suite Object” where the
nature of the object is defined in terms of the VI-
Suite.

If the currently selected Blender object is a
mesh then the first menu presented defines the
VI-Suite type. Type options include:

◦ None - there is no object level specification required. This applies for general lighting simu-
lations, and shadowing where only the geometric object data is required, and VI-Suite specific
properties are instead set at the material level. As this option generally applies to lighting geo-
metry some LiVi specifc options are presented:

� Octree generation - generates a Radiance octree for instancing

* Triangulate - triangulates the mesh before octree generation. This can clean up the
resulting octree in cases where there are non-planar quads or n-gons.

* Fallback - generates the octree from a simple face description rather than a Radiance
mesh. This must be turned off if the octree is to have textures or smoothing applied.

◦ EnVi Surface - the object represents a collection of EnergyPlus constructions.

◦ CFD Domain - the mesh object represents a computational domain for OpenFOAM analysis with
FloVi.

◦ CFD Geometry - the mesh object represents an obstruction within a domain for OpenFOAM
analysis with FloVi.

◦ Light Array - mesh the object represents an array of artificial lights, via its mesh sub-division, for
lighting analysis.

� Subsequent options allow for the selection of an IES file that defines the artificial lighting as
well as the dimensions within the IES file, its strength and colour.

◦ Complex Fenestration - the object represents an element of a repeating geometric array for
which a lighting BSDF is to be generated.

� Direction - defines the direction of the BSDF calculation.

� Proxy - whether to incorporate the geometry into the BSDF for direct light calculations.

* Length unit - converts Blender units to the selected unit for proxied geometry.

� Klem/Tensor - selects the type of BSDF angular subdivision

� Samples - how many samples per sub-division are to be used for the BSDF calculation.

� RC Params - A text box for custom Radiance rcontrib parameters.

◦ CFD Probe - the mesh object represents a region within the FloVi domain to measure flow rate.
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If the object is a Blender “Light” then the following options are presented:

◦ IES file - file opening dialogue to select an IES file Select

◦ IES dimension - sets the distance unit for any embedded geometry

◦ IES strength - a multiplier which allows the light output to be dimmed

◦ IES colour - menu to the colour type.

� RGB - uses RGB colour description

* IES RGB - sets the RGB colour

� Temperature - uses a colour temperature description

* IES Temperatuire - sets the colour temperature in Kelvin

If the object is a Blender “Empty”, a single option “CFD probe” is presented which defines this empty
as an OpenFOAM probe during a FloVi simulation.

4.10.2 Material properties panel

Figure 8: VI-Suite Material tab

In the material properties panel, VI-Suite prop-
erties are defined at the Blender material level.
For the currently selected Blender object and
currently selected Blender material (selectable at
the top of the material properties panel), a sub-
panel called ’VI-Suite Material’ will be presen-
ted. The first option in this sub-panel, the “Ma-
terial type” drop-down menu has three options:

◦ Geometry - for standard geometry suitable
for lighting/radiation and energy analysis.

◦ Light Sensor - for a material that controls
where lighting and acoustic metrics are
calculated and stored.

◦ FloVi boundary - that sets boundary condi-
tions for CFD simulations.

If Geometry is selected the following options are
specific to creating a Radiance material descrip-
tion for analysis with LiVi, and are redundant if
doing a shadow mapping (section 5.3) or SVF calculation (section 5.4):

◦ LiVi Radiance type - defines the type of Radiance material and presents relevant material para-
meters for that Radiance material type.

◦ If the LiVi Radiance type is glass, dielectric, anti-matter or translucent the following additional
option is presented

� Photon port - specifies this material as a photon port for photon mapping calculations (the
normal of any associated mesh faces should point towards the camera or sensor geometry)

◦ If the LiVi Radiance type is glass, the following additional option is exposed:

� Trans type - selects whether RGB transmission colours are used from the transmission op-
tion, or window transmittance value is used from the transmittance option.
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◦ If the LiVi Radiance type is not anti-matter, BSDF, custom or light then the following additional
options are presented:

� Textured - signifies the material as a textured material, which will cause LiVi to export the
associated geometry as a Radiance mesh, even if the mesh option in the LiVi Geometry node
is turned off. It also exposes the following options.

� Dirt noise - activates a Radiance ’dirty’ noise pattern to be applied as a modifier to the ma-
terial

* Dirt spacing - selects how dense the dirt pattern is

* Dirt level - sets how strong the dirt pattern is

� Texture image - a Blender image to be mapped to this material in Radiance (image should
be UV to geometry mapped in Blender).

� Normal map - a Blender image to act as normal perturbation for the Radiance material
(image should either be UV mapped in Blender or the UV mapping from the Texture image
can be used)

* Strength - strength of the normal map perturbation

* Vectors for the green and red components of the normal map in Blender world coordin-
ates when applied to the mesh face

� Blend mask - a black and white image to act as a Radiance material mixer. White pixels
expose the current material, black exposes a background material (image should either be
UV mapped in Blender or the UV mapping from the Texture image can be used).

* Background material - material to be exposed according to black pixels in the blend
mask image.

◦ If LiVi Radiance type is BSDF the following options are presented:

� Proxy depth - the depth of the proxy geometry in metres

* Up vector - the vector in Blender world space that defines the up direction for the BSDF

* Load/Save/Delete BSDF - option to load/save/delete a pre-existing BSDF description.

◦ Create EnVi Nodes - button to create an EnVi Material node tree associated with this material

If the material type is set to Light Sensor:

◦ Presents the same options as for the Geometry option.

If the material type is set to FloVi boundary, boundary conditions for a FloVi simulation can be set:

◦ NetGen max cell size - sets the maximum NetGen cell size on the edges and vertices of geometry
associated with this material

◦ Further options here are FloVi context specific and are detailed in section 5.8.2

4.10.3 Visualisation panel

Control of the visualisation of results within Blender’s 3D view is done within 3D Viewport sidebar,
which can be opened and closed with the ’n’ key while the mouse is over the viewport. Within the
sidebar there is a tab called “VI-Suite” (figure 9), which after a simulation will contain a button to
enable visualisation. After pressing this button the panel will get populated with visualisation options.
As the options presented in the panel are context specific, their details are discussed in the relevant
analyses sections. The example in figure 9 shows sun path visualisation options.
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Figure 9: VI-Suite Display tab

VI-Suite v0.7 also has a display framework that will create icons in the 3D viewport for the visual-
isation of certain analysis results. The icons will appear, when appropriate, in the upper left of the 3D
viewport. If these icons are clicked a data window will appear. Clicking and dragging on the upper left
corner of the data window will move it around the 3D view and clicking and dragging the bottom right
corner of the data window will resize it. The full list of icons that can be created is presented below
although the actual icons created depend on the analysis context.

◦ Legend display - this will display a colour bar that relates numerical value to colouration of
results geometry.

◦ Table display - this will display tabulated results.

◦ BSDF display - this will display a Klems tree visualisation of a calculated or loaded BSDF.

At the bottom of the "VI-Suite Display" panel is a ’Display active’ toggle. It is good practice to turn this
off before initiating another simulation, when loading another Blender file or when finished with the
display of results.

4.10.4 VI Gridify panel

The VI-Suite tab of the 3D viewport sidebar will show a VI Gridify panel when a Blender mesh object
is in edit mode, which will contain a “Grid the object” button. This button will cut a grid pattern into
selected mesh faces and is useful for creating sensor grids within sensor geometry. On pressing the
button, the selected faces of the Blender mesh object will be sliced according to the grid dimensions
and rotation options displayed in the operator panel, which will show up on the bottom left of the
3D viewport. These values can be changed and the grid pattern will live update. The operator panel
options are:

◦ Rotation - angle of rotation of the grid relative to the face normal

◦ us - grid up size (making this very small can take a long time)

◦ acs - grid across size (making this very small can take a long time)
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4.11 Common Nodes

Common nodes are nodes that do not belong to any particular simulation pipeline.

4.11.1 The VI Location node

Figure 10: VI Location node

A VI Location node can be added from the "Add >
Input nodes > VI Location" menu in the VI-Suite
Nodes window once a valid node tree has been
created. The VI Location node sets the location
of the context to be analysed in terms of latitude
and longitude and, if required, hourly weather
data from an EPW format weather file. This node
is a required node for sun-path, solar shading,
SVF, wind rose, EnVi and LiVi analyses.

The options within this node include:

◦ Source - the source of the location data

� Manual - the user specifies latitude
and longitude positions for the pro-
ject in decimal format. Latitude is -
90 to 90 degrees south-pole to north-
pole, and latitude is -180 to 180 de-
grees, with West relative to the Greenwich meridian being negative. This is the same as
the latitude/longitude numbers as reported by Google maps/Earth.

◦ EPW - the latitude and longitude values are red from the selected EPW weather file. This is re-
quired for all climate based analyses such as LiVi climate based simulations, EnVi and wind rose
analyses.

� Weather file - a drop-down menu which selects the EPW weather file. Entries in this menu
are defined by the EPW weather file directory setting in the VI-Suite addon preferences. If
this preference is not set, a directory with a couple of sample EPW included within the VI-
Suite is referenced. All files with the extension .epw or .EPW in the referenced directory
should appear in this menu.

The VI Location node has one output socket, a light green "Location out" socket, which can connect
to any light green "Location in" socket. If an EPW weather file is selected, the ’Location out’ socket can
also connect to the green input socket of the VI Chart node for plotting of the weather data.

4.11.2 The ASC Import node

Figure 11: VI ASC import node

ASCII formatted Esri Grid files are GIS data files which can
represent ground elevation data in text file format. These
files often have the extension .asc and are referred to as ASC
files here. ASC files can be exported by the Edina DigiMaps
web service that contain accurate terrain height data for
the whole of the UK.

The ASC import node can be added via the "Add > Input
Nodes > ASC Import" menu in the VI-Suite Nodes node ed-
itor once a node tree has been created. The node contains
two toggle options, a menu and an operator button. The
toggle options are:
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◦ Single File - if on, only the ASC file selected is imported. If off, all ASC files within the directory
of the selected ASC file will be imported.

◦ No data - if height data at a point is missing from the ASC file, this drop down menu mandates
what should happen at that point

� Zero - makes the height zero

� Delete - skip importing that point

The “Import ASC” button converts the ASC file into Blender co-ordinates and creates a mesh within
the scene which accurately represents the ground heights in the ASC file. Once this geometry has been
imported it can be subject to further analysis, for example a FloVi CFD analysis (figure 12).

Figure 12: Regions with wind speed above 7m/s (gltf file imported from Paraview)

4.11.3 The VI Chart node

Figure 13: VI Chart node

The VI Chart node (figure 13) uses
Matplotlib (http://matplotlib.org/) to
provide simple line plotting for certain
types of data. The node has one input
socket called “Results in” which can
link to any node output socket called
“Results out”, and the “Location out”
socket of the VI Location node which
uses an EPW file as source data. Ini-
tially only the X-axis socket is exposed. Once this socket is connected, a "Y-axis 1" socket is exposed.
Once this socket is connected, a "Y-axis 2" socket is exposed. In total three "Y-axis" sockets can be
exposed. It is possible to connect different result source nodes to the input sockets of this node but
the result length coming from each source node must be the same for a valid plot.
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Next to each connected socket, menu items will appear to select the type of data to plot on the axis.
This contents of these menu items depends on the contents of the results embedded in the connected
node. Generally the first menu is the frame (section 4.8) of a simulation to be plotted, the next is the
class of result e.g. Climate or Zone temporal, the next is the result location e.g. Exterior or zone name
and the next is the actual result. A multiplification factor option is also exposed at the end to scale the
results on a particular axis.

The options presented by the node are:

◦ X range or day range - the range of the data currently plugged into and selected to the X-axis
input socket

� Start - choose the start of the X range to be plotted

� End - choose the end of the X range to be plotted

◦ Chart type - Line/Scatter for line (only line is currently supported)

◦ Frequency - a drop-down menu to select hourly, daily, monthly results plotting. Only visible if
the X-axis data is time.

◦ DPI - the DPI of the resulting graph

A "Create plot" button in the middle of the node creates the Matplotlib plot in a new window. Buttons
within this new window allow some manipulation of the chart, associated texts, and export to image
file (see Matplotlib documentation for more details).

4.11.4 The VI Heatmap node

Figure 14: VI Heatmap node

The VI Heatmap node creates a heatmap image
based on temporal, or time based data, such as
that produced by an EnVi or LiVi CBDM analysis
or the climate data in a VI Location node. This
node replaces the 3D Viewport heatmap func-
tion from previous versions. Options within this
node include:

◦ Frame menu - this selects the frame of
the analysis to be visualised - important in
parametric analyses where multiple frames
are simulated.

◦ DPI - sets the size of the matplotlib window
opened.

◦ The next three options define the result
from the attached node to be visualised:
the first option sets the result class, the
second represents the result location and
the third represents the actual result.

◦ Days - sets the day range for the heatmap

◦ Hours - sets the hour range for the heatmap

◦ Metric range - sets the range of the result to
be plotted as a heatmap:

� Auto - plots out the minimum to the maximum of the result

� Custom - allow the setting of the lower and upper range for plotting
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◦ Colour map - selects the colormap for the plot

◦ Contour lines - Turns on contour line overlay

� Line width - sets the line width of the contour lines

� Contour values - space separated numbers to define contour line values and labels (a lone
space here produces contour lines but no labels)

◦ Contour fill - sets a filled contour

� Grid display - sets a grid overlay on the contour fill

◦ Contour levels - sets the number of contour levels for line and fill display

Figure 15: Example heatmap (diffuse solar)

4.11.5 The VI CSV Export node

Figure 16: VI CSV Export node

The VI CSV Export node can be added to a VI-
Suite Nodes node tree with the “Add Output
Nodes > CSV” menu. The node has one input
socket “VI results” for connection to a “Results
out” output socket, or a “Location out” socket if
the associated VI Location nodes uses an EPW
file as source data, and converts them to CSV
format. The CSV formatted data can then saved
to a file for third-party visualisation/processing.
If the results from the simulation contains para-
metric data the node will expose one “Animated”
option which toggles whether only the animated
parametric data or the complete static data set is
exported. The “Export CSV file” button will open up a file save window and the name and the destin-
ation of the CSV file can be specified.
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4.11.6 The Text Edit Node

Figure 17: VI Chart node

The ’Text Edit’ node in the ’Edit Nodes’ menu al-
lows for an information pipeline to be interrupted
for manual editing within Blender’s text editor. This
node currently only works with the LiVi simulation
pipeline. Once a LiVi Geometry or Context node is
connected to the ’Text in’ socket the Radiance input
text is loaded into Blender’s text editor. The name
of the text file within the text editor is also shown
within the node. If any changes are made to the text in
the text editor an ’Update’ button appears within the
node. When pressed the updated text is loaded into
the node and will be presented to any ’LiVi Simula-
tion’ node connected to the ’Text out’ output socket.

4.11.7 The VI Metrics node

Figure 18: The VI Metrics node

The VI Metrics node can benchmark simulation res-
ults based on particular environmental standards.
The VI Metrics node can also present results from
probes embedded in FloVi simulations. The node has
a single “VI results” socket input that connects to the
“Results out” socket of Embodied Carbon, LiVi, EnVi
and FloVi simulation nodes. Once a valid socket con-
nection has been made then and a valid type has been
selected, metric values will appear at the bottom of
the node, which comparisons to the chosen stand-
ard. There are also certain simulations where an in-
fographic can be created detailing compliance with
the relevant standard or encapsulating a level of per-
formance. If this option is available, a button will ap-
pear at the bottom of the node and will display either a matplotlib window or a new Blender image
editor window with an infographic image.

Options within this node include:

◦ Type - sets the metric type:

� Lighting

* RIBA 2030 - displays average daylight factor and uniformity ratio in comparison to the
requirements of RIBA 2030 Climate Challenge for LiVi Basic simulations

* BREEAM - displays average and minimum daylight factor, uniformity ratio complaint
floor area and BREEAM credits for LiVi Basic simulations

* LEED - displays sDA and ASE results in comparison to LEED v4 option 1 daylighting
requirements for LiVi CBDM simulations

� Energy

* SAP- generates a SAP score and EPC rating for EnVi simulations
· Heating type - sets the fuel type for the heating system (for gas set the conversion

efficiency of the gas heating system, for electric set the COP for heating and hot
water provision)

· Unregulated - level of unregulated energy consumption (kWh/m2)

* RIBA 2030 - displays kWh/m2results in comparison to the requirements of RIBA 2030
Climate Challenge for EnVi simulations
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· Heating type - sets the fuel type for the heating system (for gas set the conversion
efficiency of the gas heating system, for electric set the COP for heating and hot
water provision)

· Unregulated - level of unregulated energy consumption including hot water (kWh/m2)
· Type - type of building

* PassivHaus - compares space heating in kWh/m2 to the PassivHaus standard

� Flow - prints out pressure, speed and wind pressure coefficients for the selected probe

* Reference type - type of reference pressure point for WPC calculations
· Probe - reference pressure is chosen from the chosen pressure probe point
· Manual - reference pressure is manually inputted by the user

� Embodied carbon - calculates the embodied carbon for stand-alone and EnVi embodied
carbon simulations.

� Comfort - calculates overheating risk in comparison to RIBA 2030 requirements

� IAQ - calculates internal CO2levels in comparison to RIBA 2030 requirements

� WLC - calculates whole-life carbon results for EnVi simulations

* Heating type - sets the fuel type for the heating system (for gas set the conversion ef-
ficiency of the gas heating system, for electric set the COP for heating and hot water
provision)

* Unregulated - level of unregulated energy consumption, excluding hot water (kWh/m2)

* Hot water - level of hot water energy consumption kWh/m2·yr

* Carbon factor - carbon factor for local grid electricity (kgCO2/kWh)

* Annual change - annual change in carbon factor (%) associated with the local electrical
grid

� Acoustics - displays reverberation time results for sources and empty-specified listeners.

◦ Frame - sets the animation frame if looking at parametric results

◦ Zone - sets the zone name for comparison, based on the Blender object, collection, probe name
or source/listener pair if conducting a lighting, energy, flow or acoustic comparison respectively.
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4.12 Specific Analysis Nodes

Analysis nodes can be found in the "Add > Analysis nodes" menu in the VI-Suite node tree. Analysis
nodes initiate actual calculations. Some analysis nodes need to be part of a larger node set-up, for
example LiVi and EnVi simulation nodes, whereas others represent a complete analysis, for example
wind rose and shadow study nodes. These standalone analysis nodes are described here.

4.12.1 The VI Wind Rose node

Figure 19: VI Wind Rose node

The VI Wind Rose node takes wind data from an EPW
weather file and creates a wind rose plot within the 3D
viewport. The VI Wind Rose node has one input "Loc-
ation in" socket that connects to a VI Location node
"Location out" socket. As EPW data is required, EPW
must be selected as a source of information in the
VI Location node. Once a valid "Location in" socket
connection has been made the following options are
made available:

◦ Type - sets the type of plot (two types of histo-
gram and three types of contour are available)

◦ Temperature - flag to plot ambient temperature
against wind direction instead of speed.

◦ Start day - sets the first day of the year for the
plot

◦ End day - sets the last day of the year for the plot

◦ Colour - sets the colouration of the plot

◦ Max frequency - sets the maximum frequency for the plot:

� Data - maximum frequency is set to the data maximum frequencies

� Specified - maximum frequency is set to a user specified maximum frequency

Upon pressing the "Create Wind Rose" button a new wind rose object is created within the Blender
scene which can be scaled, moved or rotated as desired. This wind rose object will be placed in the
WindRoses Blender collection. Wind rose specific display options are also revealed in the VI Display
panel (section 4.10.3).

4.12.2 The VI Sun Path node

Figure 20: VI Sun Path node

The "VI Sun Path" node shown in figure 20 creates an object
within the Blender scene for sun path visualisation (section 5.1).
As the sun path analysis requires latitude and longitude data this
node has one input socket "Location in" which connects to a VI
Location node’s "Location out" socket. The VI Location node
can use either manual or EPW latitude and longitude specifica-
tion. The node contains one menu that defines the suns created:

◦ Single - single sun for a single point in time.
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◦ Hourly - a sun is created for each hour of a particular day if it is above the horizon

◦ Monthly - a sun is created for each month at a particular time if it is above the horizon.

Once a valid "Location in" socket connection has been made a button is exposed to create the sun
path, which will be placed in the Blender SunPath collection. Once the sun path object is created,
options appear in the VI-Suite Display panel (section 4.10.3) to control the day, time and size of the
sun path objects for real time visualisation of sun position.

4.12.3 Sky View Factor node

Figure 21: VI SVF node

The VI SVF node (figure 21) generates a sky view factor
(SVF) analysis. The SVF results are plotted on sensing geo-
metry given a Light sensor VI-Suite material. SVF is the
proportion of the sky that can be seen from each sensor
point and can be useful for the study of urban contexts.
The VI SVF node is a stand-alone node is it needs no other
nodes in order to conduct a calculation. The node contains
one output socket: a ’Results out’ socket to send the res-
ults to a VI Chart or VI CSV node for additional processing.
Any exported CSV file will contain the x, y, z position of
the sensing points and the sky view value at those points.
The node also contains one operator button to conduct the
calculation. Once a calculation has been conducted a ’Sky
View Display’ button will appear in the 3D Viewport side-
bar VI-Suite Display panel and result geometry will be writ-
ten to the LiVi Results Blender collection.

Options within the node are:

◦ Ignore sensor - turning this on will exclude the sensing geometry from the sky view calculation.
This should be turned on when conducting analysis on fictitious or arbitrary planes, and turned
off for physical sensing geometry such as terrain.

◦ Sky patches - this controls the resolution of the sky patches for the view factor analysis (figure
22). The more sky patches the longer the simulation time and more refined the results.

◦ Result point - to specify whether the sky view sensing points are positioned at the face centre or
vertices of the sensing object

◦ Offset - to specify the distance of the sensing point from the geometry (this is useful if the sensing
mesh has non-planar faces that would place the centre of the face below the face surface). If
results are inexplicably zero for some result points, try increasing this number.

Figure 22: Sky View Patches (Tregenza, Reinhart 577, Reinhart 2305)
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4.12.4 The VI Shadow Map node

Figure 23: VI Shadow Study node

The VI Shadow Map node (figure 23) colours sens-
ing geometry (specified by applying a Light sensor VI-
Suite material to geometry) based on the proportion
of time the geometry is exposed to direct sunshine, as-
suming clear sky conditions. The calculation is done
every specified interval during month and hour range
specified if the sun is above the horizon. The node has
one input socket; "Location in" which connects to a
VI Location node’s "Location out" socket. The VI Loc-
ation node can have either manual or EPW specified
latitude and longitude. The node also has a “Results
out” socket for connection to a VI Chart or VI Heat-
map node for plotting, or a VI CSV node for exporting
the calculated data to a CSV formatted text file.

Node options, which are only displayed once a
valid socket connection has been made, include:

◦ Ignore sensor - when turned on shading sensor
surfaces do not shadow other shading sensor
surfaces.

◦ Animation - to specify whether geometry is an-
imated or static.

� Static - no parametric analysis

� Geometry - a geometry based parametric
analysis

* Frames - the start and end frame for the parametric analysis

◦ Start & end day (with day/month label) - to specify the day range for analysis.

◦ Start & end hour - to specify the daily hour range (1st to 24th).

◦ Hour steps - number of calculation steps per hour.

◦ Result point - to specify whether the shadow sensing points are positioned at the face centre or
vertices of the sensing object

◦ Offset - to specify the distance of the sensing point from the geometry (this is useful if the sensing
mesh has non-planar faces that would place the centre of the face below the face surface). If the
results are inexplicably zero for some result points try increasing this number.

After simulation, options are available on the VI-Suite Display panel for result visualisation within the
3D viewport. The “VI results” output socket can also be connected to a VI CSV node for data export or
VI Chart node for plotting.

4.12.5 The VI Embodied Carbon node

The VI Embodied Carbon node (figure 24) allows for a stand-alone calculation of embodied carbon
based on Blender mesh geometry. The analysis requires Blender mesh objects to have been given ap-
propriate embodied carbon data via the VI-Suite Object panel. The options presented within this node
are:
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Figure 24: VI Embodied Carbon node

◦ Entities:

� Objects - embodied carbon metrics are cal-
culated per Blender mesh object

� Collections - embodied carbon metrics are
calculated per Blender collection

◦ Parametric - allows for a parametric run to be
simulated based on a frame range:

� Start frame - Start frame for the parametric
run

� End frame - End frame for the parametric
run

◦ Heal - toggle that will attempt to heal Blender geometry to make it manifold. Non-manifold
geometry details will be written to the vi-suite-log file.

◦ Floor area - for kgCO2e/m2of floor area calculations this number specifies the floor area in m2.

◦ Timeframe - the overall time frame over which the embodied carbon calculation is to be con-
ducted (default is 60 years).

A “VI results” output socket will be exposed after simulation for connection to a VI Chart, VI CSV or VI
Metrics node.

Dr Ryan Southall 26 School of Architecture, Technology & Engineering



VI-Suite v0.7 4 The VI-Suite Interface

4.13 LiVi Nodes

LiVi nodes control and specify a LiVi simulation for the prediction of lighting metrics.

4.13.1 The LiVi Geometry Export node

Figure 25: LiVi Geometry node

The LiVi Geometry node (figure 25) can be added to a VI-
Suite Nodes tree with the ’Add > Process nodes > LiVi Geo-
metry’ menu entry and exports Blender geometry and ma-
teriality to a format that can be understood by the Radi-
ance lighting simulation suite. All unhidden lights, geo-
metry (that has the VI-Suite object definition “Geometry”
or “Light sensor”) and materials in the Blender scene are
exported and the Radiance description stored within the
node. An exception to this is objects or materials with “/”
in the name, as this is not supported by Radiance. Some
geometry options here are:

◦ Triangulate - will triangulate the mesh before Radi-
ance export. This may be useful where the meshes
contain weird N-gon geometry.

◦ Mesh - if disabled, each mesh face is written out in-
dividually to Radiance format, unless the object has a
textured material associated with it. If enabled, Radiance meshes are exported for each Blender
object. Mesh export can be slower to simulate but is required for mesh smoothing in Radiance,
which is enabled by turning on object smoothing and creating custom split normals for the ob-
ject in Blender.

◦ Animated - sets if the geometry or materiality changes for a parametric analysis

� Frames - the start and end frame of the parametric analysis

◦ Result point - specifies of the sensing points are based at the vertices of face centres of the sensing
geometry

◦ Offset - this option is useful for non-planar n-gon or quad surfaces where the average central
point of a face centre is actually below the face surface. If calculated results are inexplicably zero
on some faces, try increasing this value.

The node has one ’Geometry out’ output socket that can connect to the ’Text in’ socket of a VI Text Edit
node or the ’Geometry in’ socket of a LIVi Simulation or LiVi Image node.

4.13.2 The LiVi Context node

The LiVi Context node (figure 26) controls the export of a lighting simulation context to a text format
that Radiance can understand. In terms of a Radiance simulation, context means the type of sky the
building is exposed to, the time of day and year and the metrics to be calculated. This node can create
two different categories of sky context: “Basic”, for simple lighting metrics, and “CBDM”for climate
based daylight modelling.

The node has one input socket and one output socket. The input socket is a "Location in" socket
for connection to a VI Location node’s "Location out" socket (if a LIVi CBDM analysis is required then
EPW must be set as a source of climate data in the VI Location node). Once a valid connection on
this socket has been made, options will appear and an “Export” button will be presented. On pressing
this button the sky context is stored within the node.. The output socket is a "Context out" socket for
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connection to a “Text in” socket of a VI Text Edit node or the “Context in” socket of a LiVi Image or LiVi
Simulation node.

(a) LiVi Basic (b) LiVi CBDM

Figure 26: LiVi Context node

Node options are dynamic and presented only if appropriate for the type of analysis selected, which
is set with the first “Context” menu. The “Context” menu options are:

◦ Basic - for basic lux, W/m2 and daylight factor calculations:

� Program - sets the sky generator

* Gensky - uses Radiance’s Gensky program to generate the sky
· Sky type - sunny, partly cloudy, cloudy, daylight factor and no skies are supported
· Turbidity - sets the turbidity for the sky

* Gendaylit - uses Radiance’s Gendaylit program to generate the sky
· Spectrum - choose visible or solar spectrum radiation
· Colour sky - Enables a coloured sky description
· Epsilon - sets the epsilon value for the generated sky
· Delta - sets the delta value for the generated sky

* HDR Sky - allows the loading of an existing HDR image as a Radiance sky texture
· HDR format - ’Angular’ for angular maps and ’Polar’ for conventional latitude-longitude

format (equirectangular in Blender)
· HDR rotation - environment map centre is south by default, a degrees rotation can

be specified with this option.
· HDR distance - radius of the sphere in metres upon with the Radiance sky texture is

mapped

* Radiance Sky - allows the loading of a pre-existing Radiance text file sky description
from Blender’s text editor

* None - no sky (can be useful for artificial lighting calculations)

� Ground ref - sets the ground reflectivity

� Ground col - sets the ground colour

� Sun distance - as this node creates a sun within the Blender scene, positioned relative to the
blender world origin in accordance with the settings within this node, this option sets the
distance of the sun from the world origin.
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� Start hour - hour time for sky creation (decimal input, hours and minutes are shown in the
option label)

� Start day - day of the year for sky creation (integer input, day of the year is shown in the
option label)

� Animation - sets a parametric sky creation. If on, the following options are presented:

* Start frame - sets the start frame for the animation

* End frame - this is an auto-calculated number based on the options below

* End hour - end hour for the simulation (decimal input, hours and minutes are shown
in the option label).

* End day for the simulation (integer input, day of the year is shown in the option label).

* Interval (hours) - the amount of time between simulations.

� Turbidity - sets the turbidity of the sky

� HDR - creates an HDR image of the sky in the project directory that can be used as an en-
vironment texture in Blender.

� Split channels - keeps separate the three frequency bands simulated

◦ CBDM

� Type:

* Exposure - generates a cumulative HDR image of the sky for the simulated duration for
exposure calculations

* Hourly irradiance - calculates full spectrum irradiance exposure for each hour of the
simulation

* DA/UDI/SDA/ASE - calculates conventional CBDM metrics
· (s)DA Min lux - sets the minimum lux level for (spatial) Daylight Autonomy
· UDI Low (Max) - sets the maximum lux level for the Useful Daylight Illuminance

(UDI) low level
· UDI Supplemental (Max) - sets the maximum lux level for the UDI supplemental

level
· UDI Autonomous (Max) - sets the maximum lux level for the UDI autonomous low

level
· ASE level - sets the upper limit for ASE calculations.

* Glare - calculates annual glare metrics
· Hourly DGP - calculates an hourly glare occurance/autonomy in addition to an an-

nual summary for heatmap visualisation
· DGP threshold - sets the glare probability threshold for glare occurance/autonomy
· Views - sets the number of view directions for the glare simulation
· Azimuth - sets the azimuth of the first view direction (each subsequent view azi-

muth is calculated as an additional 360°/Views clockwise rotation)

◦ All year - does the calculation for an entire year

� If off, start and end day and hour can be set

◦ Weekdays - only calculate a sky for weekdays if, for example, simulating a commercial environ-
ment

◦ LEED v4 - sets ASE and (s)DA levels for a LEED v4 calculation if “Type” is set to DA/UDI/SDA/ASE

◦ Source file:

� EPW - generates sky data from the EPW file selected in the VI Location node
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� HDR - use a pre-generated HDR sky for exposure calculations

� VEC - use a pre-generated vector description of a sky for CBDM and irradiance analyses

◦ Resolution - sets the patch resolution for the generated sky (1 = 147 patches, 2 = 578 patches)

◦ HDR - generates a composite HDR panorama of the sky in the project directory.

4.13.3 The LiVi Simulation node

Figure 27: LiVi Simulation node

The LiVi Simulation node (figure 27) can be added to the
VI-Suite Nodes tree with the “Add > Simulation nodes >
LiVi Simulation” menu entry. This node takes geometry
and context from LiVi Geometry and LiVi Context nodes
and calculates the chosen metric on sensing geometry. The
"Calculate" button, which is only visible if there is valid
sensing geometry, initiates the simulation. When the "Cal-
culate” button is pressed the Blender interface will lock up
during the simulation but a Kivy window will appear that
shows an estimate of simulation duration, and presents a
cancel button to terminate the simulation.

The node has two input sockets: "Context in", which
accepts connections from a "Context out" socket of a LiVi
Context node and "Geometry in" for connection to the
"Geometry out" socket of a LiVi Geometry node. Once
valid socket connections have been made the following
node options are exposed:

◦ Frames - auto-generated text label showing the frame range to be simulated based on the extents
of the frame ranges set in the LiVi Geometry and LiVi Context nodes.

◦ Photon map - this enables Photon mapping, a forwards ray-tracing technique that is very useful
when rays from the calculation point find it difficult to find a light source. If using a custom
Radiance installation, at least version 5 of Radiance is required:

� Global photons - sets the number of global diffuse photons to be emitted and registered
within the scene

� Caustic photons - sets the number of specular photons to be emitted and registered within
the scene

� Back face visibility - this makes both sides of planes accept photons.

� Photon options - text box to set advanced options for the mkpmap program. Refer to the
Radiance photon mapping manual for more information about potential options.

� Preview photons - when pressing the “Preview” button this will create spheres within the
Blender scene to map where global and caustic photons have landed. The global photons
object is called GlobalPM and the caustic CausticPM and both are saved to the LiVi Results
Blender collection.

◦ Accuracy - sets an accuracy preset:

� LiVi Basic offers low, medium and high settings

� LiVI CBDM offers initial and final settings

� All analyses types offers custom parameters - a text box where Radiance simulation para-
meters can be specified
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◦ Camera - a drop-down menu to choose a Blender camera to preview the scene with Radiance.
Only available if LiVi Basic, or a LiVi CBDM exposure analysis is being conducted.

◦ Preview - button to open a Radiance rvu window to preview the scene from the perspective of
the chosen camera. Only available if LiVi Basic, or a LiVi CBDM exposure analysis is being con-
ducted.

4.13.4 The LiVi Image node

A LiVi Image node can be added to the VI-Suite Nodes tree with “Add > Image Nodes > LiVi Image”
menu entry. The LiVi Image node creates a Radiance image from the information embedded in the
LiVi Geometry and LiVi Context nodes and has the same input socket connections as a LiVi Simulation
node. Once valid connections have been made, at the top of the node the simulation frame range
generated by the LiVi Geometry and LiVi Context nodes will be shown. Image(s) are created from the
perspective of the chosen Blender camera with the node’s “Image” button, and will be saved to the
project directory/images folder with the name(s) base name-frame.hdr where base name is set within
the node and frame is the simulation frame. During creation of the image, a preview of the developing
image will be displayed in the livi_preview image in Blender’s image editor.

Figure 28: LiVi Image node

Once valid socket connections are made, and a Blender
camera selected with the drop down box, options in the
node will appear. These options include:

◦ Camera - Blender camera selection menu

◦ Base name - base name for the images produced

◦ Illuminance - turns on an illuminance image rather
that a luminance image (illuminance images will
make all initial ray hits based on white, diffuse geo-
metry)

◦ Fisheye - creates a fisheye image

� FOV - field of view in degrees (should be 180 for
glare analysis)

◦ Accuracy - sets the Radiance accuracy

� Options here are the same as the LiVi Simulation
node

◦ Normal - generates an additional coloured image of
surface normals for later de-noising with Blender

◦ Albedo - generates an additional coloured image of
surface albedo for later de-noising with Blender

◦ Photon map - turns on the Radiance’s photon map-
ping capability

� Options here are as for the LiVi Simulation node

◦ Preview - creates a preview of the scene with Radiance’s rvu program

◦ X resolution - sets the X pixel resolution of the image

◦ Y resolution - sets the Y pixel resolution of the image
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◦ Multi-thread - on Linux and OS X enables multi-processing

� Processors - sets the number of processors available for multi-processing

� Processes - splits the image into this many segments for multi-processing

◦ Image - creates the image(s)

4.13.5 LiVi Glare node

Figure 29: LiVi Glare node

The “LiVi Glare” node can be added to a VI-Suite Nodes tree
from the ’Add > Image nodes > LiVi Glare’ menu entry. It
has one LiVi Image input socket which connects to the out-
put of a LiVi Image node and processes the images created
to evaluate glare probability.

Glare analysis works on fisheye images so the fisheye
option should have been selected in the LiVi Image node
and an FOV of 180 degress set. The “Illuminance” option
should also be turned off in the LiVi Image node. In addi-
tion, glare analysis on fisheye images larger than 1000x1000
pixels can take a long time. Glare images are stored in the
Project directory/images folder.

The node contains two options:

◦ Base name - sets the base name of any generated images, which are given the name base name-
frame.hdr

◦ Random - randomly colours glare sources if on. Allows a single colour selection for all glare
sources if off

� Colour - if “Random” is off, select colour for all glare sources

4.13.6 LiVi False Colour node

Figure 30: LiVi False Colour node

The LiVi False Colour node can be added to the node tree
with the “Add > Image nodes” menu in the VI-Suite Nodes
tree window. The LiVi False Colour node applies a false col-
our filter to Radiance HDR images, which can come from
the LiVi Image node or be loaded from disk. This filter col-
ours the image according to the lighting data embedded
within it. If the image comes from the LiVi Image node, the
type of data embedded in the image depends on options
in the LiVi Context and LiVi Image nodes. If, for example,
the LiVi images are generated with the “Visible” spectrum
option in the LiVi Context node, then illuminance (lux) or
luminance (cd/m2) data is available. Which is of these is
available is determined with the “Illuminance” option in
the LiVi Image node. If the “Full” spectrum option is used
in the LiVi Context node then irradiance (W/m2) and radi-
ance (W/m2.sr) are available, again switched between with
the “Illuminance” option in the LiVi Image node. If loading
the file from disk, then the user should be aware of which
unit is embedded in the image.

The node has one input “Image” socket. If this socket
is not connected the user can load an hdr image from disk
with the node’s file browser. If the socket is linked to a LiVi
Image node then the images created with that node can be processed.
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Once either an image has been loaded or a valid socket link has been made, the following options
are presented:

◦ Base name - text box to set the base name for the produced false colour image (file name will be
base name-frame.hdr)

◦ Unit - text box to set the legend unit

Once a unit has been entered the following options are presented:

◦ Multiplier - sets a multiplication or division factor for the results (/100 would divide the results
by 100, *100 would multiply by 100)

◦ Colour - sets the legend and image colour scale

◦ Divisions - sets the false colour divisions

◦ Legend - turns on legend display

◦ Scale - sets the legend number scale: linear or logarithmic

◦ Legend max - sets the maximum legend number

◦ Legend width/height - sets the display width/height of the legend

◦ Contour - draws contours over the image

� None - no contours

� Contour - draws contour lines at legend colour boundaries

� Bands - draws bands at legend colour boundaries

� Poster - fills the image with legend colour designations

� Overlay - overlays the contours over a selected image

* Overlay file - selects the image to overlay contours

* Sets the exposure (as a multiplier) of the overlaid image
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4.14 EnVi Nodes

EnVi nodes control the main phases of an EnergyPlus simulation: The EnVi Geometry node processes
Blender geometry for export; the EnVi Export node exports processed geometry and context to En-
ergyPlus format; the EnVi Simulation node runs the Energyplus simulation.

4.14.1 The EnVi Geometry node

Figure 31: EnVi Geometry node

The EnVi Geometry node (figure 31) processes
Blender scene geometry and materiality into a
form more suitable for EnergyPlus analysis. The
node contains one "Export" operator button.
Upon pressing the "Export" button the node du-
plicates all visible mesh objects designated as
EnergyPlus surfaces and all mesh faces with an
EnergyPlus material associated and places them
into their own collections.

The node has the following option:

◦ Offset - sets a positional offset for the duplicated geometry.

4.14.2 The EnVi Context node

Figure 32: EnVi Export node

The EnVi Context node converts the modified Blender geo-
metry and materiality within the EnVi Geometry collection
to a valid EnergyPlus text description, and combines it with
the weather data specification in the connected VI Loca-
tion node, which must have "EPW" selected as its inform-
ation source. The context and desired simulation metrics
presented within this node complete an EnergyPlus text in-
put file. The input file created is called inframe.idf, where
frame is the Blender frame being simulated, and is stored
in the project directory. It is also registered within Blender’s
text editor, and can be edited before eventual simulation if
required.

The node has two input sockets: "Geometry in" for con-
nection to an EnVi Geometry node’s "Geometry out" socket
and "Location in" to connect to a VI Location node’s "Loc-
ation out" socket, and one output socket "Context out",
for connection to an EnVi Simulation node’s "Context in"
socket.

If valid input socket connections are made, node op-
tions are presented and an "Export" button will appear at
the bottom of the node. Options are:

◦ Shadow - sets the method for shading calculations:

� CPU - uses the cpu.

� GPU - uses the graphics card. GPU can be
quicker if there are a large number of shading surfaces.

◦ Animation - designates an animated/parametric EnergyPlus export

� Start frame - sets the beginning frame for the parametric analysis
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� End frame - sets the end frame for the parametric analysis

◦ Name/location - provides a text box for the optional entry of an EnergyPlus project name

◦ Solar - sets the accuracy of solar radiation gain calculations (refer to EnergyPlus documentation)

◦ Exposure - specifies the level of wind exposure the building is subject to.

◦ Start/end day - specifies the beginning and end day for the simulation.

◦ Time steps - specifies the number of simulation time steps per hour

◦ Results category - chooses the class of metrics to be calculated and presents individual tick boxes
for specific metrics within the chosen class. Options are:

� Zone Thermal - zone heating, cooling, temperature and humidity results

� Comfort - zone PPD, PMV, MRT and occupancy levels

� Zone Ventilation - zone infiltration, exfiltration and CO2

� Ventilation Link - flow rates, opening factors and pressure differences in ventilation net-
works

� Power - photovoltaic power production and efficiency

� Surface - surface inside and outside temperatures

Upon pressing the “Export” button the inframe.idf file is created in the project directory and the "Con-
text out" socket will become visible for connection to the “Context in” socket of the EnVi Simulation
node..

4.14.3 The EnVi Simulation node

Figure 33: EnVi Simulation node

The EnVi Simulation node (figure 33) initiates an En-
ergyPlus simulation. The EnVi Simulation node has two
sockets: "Context in" for connection to an EnVi Context
node’s "Context out" socket, and a "Results out" socket for
connection to a VI Chart node, VI Heatmap node, VI Met-
rics node or a VI CSV node. The node contains a text box
into which the name of the EnergyPlus results file (default
is "results") can be specified. Once a valid socket connec-
tion has been made to the "Context in" socket a "Calcu-
late" button appears, which when pressed initiates the En-
ergyPlus simulation. The node will then turn red and will
monitor the EnergyPlus simulation and give a prediction of
simulation progress with a Kivy window. The Blender interface should remain interactive during sim-
ulation but no changes to the Blender scene should be made while the simulation is running. A results
file, with the name results nameframeout.eso, is saved in the project directory upon completion.
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4.15 EnVi Network Nodes

EnVi Network Nodes are used within the EnVi Network node tree to specify zone schedules and natural
ventilation networks.

4.15.1 The EnVi AFN node

Figure 34: EnVi AFN

The EnVi AFN node is created automatically
within the EnVi Network node tree during EnVi
geometry conversion but is only relevant if EnVi
airflow surfaces are present. If accidentally de-
leted, the node can be recreated with the ’Add
> Airflow Nodes > Airflow Control’ menu. The
EnVi AFN node specifies the high level options
for a ventilation network. For more details of
these options refer to the “AirflowNetwork:Sim-
ulationControl” entity in the EnergyPlus in-
put/output reference document but options the
user may need to change include:

◦ Name - allows for an optional custom
name to bet set for the airflow network

◦ WPC type - sets the calculation for external
wind pressure coefficients

� SurfaceAverageCalculation - automatic
calculation based on the building ty-
pology options in this node

* Build type - sets whether the building is high rise or low rise

* Azimuth - azimuth angle of the long axis of the building

* Axis ratio - ratio of the long axis to the short axis of the building

� Input - input wind pressure coefficients
calculated by, for example, FloVi.

* WPC height - sets the height for the wind pressure coefficients
· OpeningHeight - automatically set according to the height of the airflow network

components
· ExternalNode - set by the External nodes attached to each external airflow compon-

ent

* Setting “Input” will expose an Azimuth array input socket for the connection of an EnVi
Azi node
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4.15.2 The EnVi Azi node

Figure 35: EnVi Azi node

This node can be added by selecting the ’Add > Airflow
Nodes > Azimuth Array’ menu entry in an EnVi Network
node tree. The node supplies azimuth angles, in clockwise
degrees from North, for all the wind pressure coefficients
applied to external building surfaces via the EnVi External
nodes in the EnVi Network node tree, and connects to the
EnVi AFN node via a single Azimuth array output socket.

Options presented in this node are:

◦ Azimuth source - the source of the azimuth angle
data

� Manual - up to 12 azimuth angles can be entered
manually (these must be in ascending order and
the list will terminate if values descend)

� CSV - azimuth angles are read from a CSV
formatted file (the CSV file should contain only
one column with the word azimuth in the first
row header)

* File opening dialogue to open the CSV file

* Azimuth angles are then displayed from the
CSV file

In the example in figure 35, 4 azimuth angles have been
manually input in ascending order and the rest are ignored.

4.15.3 The EnVi Zone nodes

Figure 36: EnVi Zone node

EnVi Zone nodes are created automatically in the EnVi Network
node tree during EnVi geometry conversion for each thermal
zone, or collection, that was exported. The node represents an
EnergyPlus ’Zone’ entity, so see the EnergyPlus documentation
on this entity for further details of the options available. Input
sockets are created for HVAC, occupancy, equipment and air in-
filtration schedules. If EnVi material constructions associated
with the objects within an exported collection have airflow or
zone boundary characteristic, sockets are also created for these
surfaces. Boundary sockets are coloured brown, surface airflow
sockets red and sub-surface airflow socket green. These addi-
tional sockets are created on both sides of the node for easier
arrangement of connections within the node editor.

Core options within this node are:

◦ Zone - auto-generated name of the Blender collection that
represents an EnergyPlus zone. If the node is accidentally
deleted, a new node can be created with the ’Add > Zone
nodes > Zone’ menu and a name manually inputted. This
should correspond exactly to the name of the collection
and is case sensitive.

◦ Inside convection - sets the routine for internal surface convection
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◦ Outside convection - sets the routine for external surface convection

◦ Volume calc:

� Auto attempts to calculate the zone volume from the objects in the collection

* Auto volume - auto generated text of the calculated volume (this should be checked to
make sure the calculated volume corresponds to expectations. Use the manual option
if not)

� Manual - the user can enter a volume (m3)

◦ Control type - sets the zone level of control of any airflow openings:

� Constant - openings can always open

� Temperature - opening is restricted based on zone temperature

* Minimum OF - the minimum opening factor

* Lower - the lower temperature difference threshold

* Upper - the upper temperature difference threshold

* An additional node input socket called TSPSchedule is exposed for the connection of a
Schedule node to set the temperature at which air flow openings operate.

The core node input sockets exposed are:

◦ HVAC - for the connection of an HVAC node to set heating and cooling provision

◦ Occupancy - for the connection of an Occupancy node to set occupancy levels

◦ Equipment node - for the connection of an Equipment node to set equipment heating gains

◦ Infiltration - for the connection of an Infiltration node to set simple zone air infiltration

◦ VASchedule - for the connection of a Schedule node to set when airflow openings are available.
If not connected ventilation openings are always available.

In addition to these core sockets, additional sockets will be created if EnVi construction materials with
a boundary or airflow characteristic are associated with an object within the collection. These sockets
will initially appear on both sides of the node but will disappear from the opposite side as they get
connected. These additional sockets are:

◦ Boundary sockets - coloured brown are for connection to the corresponding boundary socket of
another zone node.

◦ Surface airflow sockets - coloured red are for the connection to a surface airflow node.

◦ Sub-surface airflow sockets - coloured green are for the connection to a sub-surface airflow node

These additional socket names are derived from the name of the material associated with the face, the
index number of the face and at the end of the socket name an "s" denotes a surface or sub-surface
flow and "b" at the end of the socket name would denote a boundary surface. For information on
visualising face index numbers see section 4.4)

Boundary sockets should be connected to another boundary socket on another zone node. The
VI-Suite then assumes that the connected surfaces represent a boundary between these two zones. If
a boundary node is left unconnected the VI-Suite will consider this is an external boundary as if an
“External” boundary condition had been set for the associated face material.

Surface and sub-surface flow sockets must be connected to an EnVi Surface flow node (section
4.15.9) or an EnVi Sub-surface flow (node section 4.15.10) respectively. If a flow node is only connected
to one zone, this flow component is considered to sit on the external boundary of the building. If the
flow node has another connection to another zone node, the flow component is considered to sit on
the boundary between these two zones.
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When all airflow sockets are connected the node becomes valid and will turn the default colour. It
should be noted that if airflow surfaces are designated, then each EnVi zone must have at least two
airflow surfaces specified within it during geometry creation, and at least two pairs of flow sockets
should appear in the node.

4.15.4 The EnVi HVAC node

Figure 37: EnVi HVAC node

The EnVi HVAC node is available in the ’Add - Zone Nodes
> HVAC’ menu in an EnVi Network node tree and specifies
heating and cooling levels for a connected EnVi Zone node
by creating an EnergyPlus IdealLoadSystem entity. For fur-
ther details of the options within this node refer to the
EnergyPlus inputoutput reference document entry for this
entity.

As EnergyPlus was developed in the United States
where the heating and cooling of buildings with air is com-
mon, and of the EnergyPlus options pertaining to the sup-
ply of heating and cooling reflect this. Node options are
broken down into three sections: heating, cooling and out-
door air. Most of the heating options have a direct corollary
in the cooling section of the node. The level of outdoor air
supplied by the heating/cooling system can be used as a
simple method to calculate the impact of MVHR systems.
Options within this node include:

◦ Heating limit:

� None - no heating.

� No limit - heating is unlimited in terms of the air
flow rate that can be supplied or the capacity to
heat the air

* Heating temp - temperature of the supply
air (oC)

* Thermostat level - zone temperature below
which heating is applied (oC)

◦ LimitFlowRateAndCapacity - limit the overall capacity and the airflow rate of the heating system.

� Heating temp - temperature of the supply air (oC)

* Heating airflow - maximum volume flow rate of the supply air (m3/s)

* Heating capacity - maximum heating capacity of the supply air (W)

* Thermostat level - zone temperature below which heating is applied (oC)

� LimitCapacity - limit only the overall capacity of the heating system.

* Heating temp - temperature of the supply air (oC)

* Heating capacity - maximum heating capacity of the supply air (W)

* Thermostat level - zone temperature below which heating is applied (oC)

� LimitFlowRate -limit only the airflow rate of the heating system.

* Heating temp - temperature of the supply air (oC)

* Heating airflow - maximum volume flow rate of the supply air (m3/s)

* Thermostat level - zone temperature below which heating is applied (oC)
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◦ Heat recovery - turns on sensible heat recovery.

� HR eff. - sets the heat recovery efficiency

◦ Outdoor air

� None - purely recirculating air heating system

� Flow/Zone - flow for the zone (m3/s)

� Flow/Person - flow per current occupant

� Flow/Area - flow per m2 of floor area (m3/s/m2)

� ACH/Detailed - air changes per hour

� Sum - sum of all the outdoor air flow types

� Maximum - maximum of the outdoor air flow types

In addition, the node has three input sockets:

◦ Schedule - for the connection of a schedule node to determine when the heating/cooling system
is available (schedule values: 0 or 1).

◦ HSchedule - for the connection of a schedule node to provide time varying heating thermostat
set point temperatures (schedule values: temperature).

◦ CSchedule - for the connection of a schedule node to provide time varying cooling thermostat
set point temperatures (schedule values: temperature).

4.15.5 The EnVi Occupancy node

Figure 38: EnVi Occupancy node

The EnVi Occupancy node is available in the “Add >
Zone Nodes > Occupancy” menu in an EnVi Network
node tree and specifies the type and nature of any oc-
cupancy within a connected EnVi zone node. Occu-
pancy is set as a maximum occupancy level within
this node and an attached schedule node can set the
fractional schedule of this maximum level. The op-
tions within the node control:

◦ Type of occupancy:

� None - no occupancy.

� Occupants - occupancy in terms of number
of people.

* Max level - maximum number of occu-
pants

* Activity level - metabolic sensible heat
output per person (W/p)

� Persons/m2- number of people per square
meter of floor area.

* Max level - maximum number of
people per square metre

* Activity level - metabolic sensible heat
output per person (W/p)

� m2/person - square meter of floor area per
person.
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* Max level - maximum number of square metres per person (in terms of occupancy the
max level is the lowest number)

* Activity level - metabolic sensible heat output per person (W/p)

◦ Comfort calc - turn on thermal comfort calcula-
tions

� Work efficiency - proportion of the metabolic rate expended in useful work

� Air velocity - average air velocity for comfort calculation (m/s)

� Clothing - clothing level of the occupants (clo)

� CO2 - turn on the calculation of internal CO2 levels

The node also contains sockets for the connection of schedule nodes:

◦ OSchedule socket is for the scheduling of occupancy level as a proportion of the maximum spe-
cified occupancy (schedule type - fraction)

◦ ASchedule socket for the schedule of the absolute metabolic rate (schedule type - value)

◦ WSchedule for the scheduling of the proportional level of the work efficiency (schedule type -
fraction)

◦ VSchedule for the scheduling of absolute air velocity in m/s (schedule type - value)

◦ CSchedule for the scheduling of absolute clo clothing level (schedule type - value).

4.15.6 The EnVi Equipment node

Figure 39: EnVi Equipment node

The EnVi Equipment node is available in the “Add
- Zone Nodes” menu in an EnVi Network node
tree and specifies the level of mechanical and
electrical internal heat gains. The node con-
tains one “Equipment” output socket for connec-
tion to the “Equipment” input socket of an EnVi
Zone node. The node also contains an input
socket for the connection of a schedule node
to set a scheduled value for the specified heat
gain.

The options within this menu include:

◦ Type - sets the type of equipment gain.

� None - no gains

� EquipmentLevel - sets the total Watts of internal gains for the zone (W)

� Watts/area - sets the internal gains in Watts per square metre of floor area (W/m2)

� Watts/person - sets the Watts per occupant (W/p)

◦ Max level -sets the maximum gain based on the previously selected gain type.

◦ Schedule - an input socket that accepts a schedule for gains of the type selected (schedule type -
amount)

4.15.7 The EnVi Infiltration node
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Figure 40: EnVi Infiltration node

The EnVi Infiltration node is available in the ’Add >
Zone Nodes > Infiltration’ menu in an EnVi Network
node tree and sets a constant or scheduled level of
fresh air infiltration into a zone. If an air-flow network
is specified this node, and the settings within it, will be
ignored. The node contains one “Infiltration” output
socket for connection to an “Infiltration” input socket
of an EnVi Zone node, and one input socket for the
connection of a schedule node to specify a fractional
infiltration rate.

The node sets two options:

◦ Type - sets the type of infiltration

� None - no infiltration

� Flow/Zone - total flow for the whole zone in m3/s.

� Flow/Area - flow per square metre floor area in m3/s·m2

� Flow/ExteriorArea- flow per square metre of exterior surface area in m3/s·m2

� Flow/ExteriorWallArea - flow per square metre floor of exterior wall area in m3/s·m2

� ACH - total flow in air changer per hour

◦ Level- sets the level for the previously selected infiltration type.

◦ Schedule - an input socket to attach a schedule node (schedule type - fraction)

4.15.8 The EnVi Net Schedule node

Figure 41: EnVi Schedule node

The EnVi Net Schedule node can be found in the ’Add
> Schedule’ menu in the EnVi Network node tree. A
schedule node creates an EnergyPlus schedule, which
is used to control an input’s time dependence e.g
when windows are open. All EnVi schedules basic-
ally operate over defined periods of a year, for defined
days within that period, and defined hours of those
days. The node options reflect the specification of
these three layers of time data. Values provided are
either absolute values e.g. a thermostat temperature
schedule, or fractional e.g. the proportion of occu-
pancy schedule. The node is initially red and will only
become the default colour when the options below are given valid values.

These options are:

◦ Source - only Node works and simply reads the schedule from the options below

◦ "End day 1" - sets the end day of the first scheduled year period, which will start at 1. This defaults
to 365, the last day of the year.

◦ "Fors" - sets the day types (valid day types are: Alldays, Weekdays, Weekends, Monday, Tuesday,
Wednesday, Thursday, Friday, Saturday, Sunday and AllOtherDays) for the above year period in
a space separated list. weekdays weekends would for example set two day types for the next
"Untils" option.

◦ "Untils" - sets the schedule values with space separated end hour:minute/value pairs, comma
separated for each period within a day type and semi-colon separated for each day type. A whole
day period must be covered so 24:00 should always be the last time specified.
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If the first end day is less than 365 the three options above are repeated for the next year period. Up to
four year periods can be set.

For example, in figure 41 for the first period up to day 90, then for all days in that period the sched-
ule is 0 until 08:00, 1 until 18:00 and 0 until 24:00. For the next period from day 90 to the end of the year
(day 365) for weekdays the schedule is 0 until 08:00, 1 until 20:00 and 0 until 24:00, and for weekends
the schedule is 0 until 24:00. The node presented in figure 41 represents a fraction schedule where the
schedule values are the decimal fraction of a maximum value. Refer to the EnergyPlus user manual for
clarification of what schedule type is required to control which parameter.

4.15.9 The EnVi Surface Flow node

Figure 42: EnVi Surface flow node

The EnVi Surface flow node creates a permanent apertures
within a solid building construction such as a wall, floor or
roof. It contains two input sockets "Node 1" and "Node 2",
and two output sockets "Node 1" and "Node 2". Having
sockets on both sides of the node makes node connections
within the node tree more flexible but only one needs to be
connected, so if a node socket on one side of the node is
connected, the similarly named socket on the other side of
the node will disappear. All of these sockets are for connec-
tion to the surface flow sockets of EnVi Zone nodes.

If both "Node 1" socket and "Node 2" sockets are con-
nected to two different EnVi zones the surface flow node
is assumed to specify a flow component between the two
zones. If only one socket is connected to an EnVi Zone
node, the surface flow is assumed to sit on the external
boundary of the zone and control airflow between the zone
and the outside air. If "Input" is selected for the "WPC
type" in the EnVi AFN node, an EnVi External node must
then be connected to the other socket to represent outside conditions.

Options in this node include:

◦ Type - the type of flow component (effective leakage area (ELA) or crack)

� ELA - aperture is represented by an effective leakage area

* ELA (m^2) - area in m2

* DC - discharge coefficient

* PA diff - reference pressure difference (Pa)

* FE - flow exponent

� Crack - aperture is represented by a crack

* Coefficient - flow coefficient

* Exponent - flow exponent
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4.15.10 The EnVi Sub-surface Flow node

Figure 43: EnVi Sub-surface flow node

The EnVi Sub-surface Flow node creates a flow com-
ponent within an opening building construction such
as a window or door. It contains two input sock-
ets "Node 1" and "Node 2", and two output sockets
"Node 1" and "Node 2". All of these sockets are for
connection to the sub-surface flow sockets of EnVi
Zone nodes. If a node socket on one side of the node
is connected the similarly named socket on the other
side of the node will disappear. This makes node con-
nections within the node tree more flexible. If both
"Node 1" socket and "Node 2" socket are connected
to two different EnVi zones the subsurface flow is as-
sumed to control airflow between the two zones. If
only one socket is connected to an EnVi zone node the
surface flow is assumed to sit on the external bound-
ary of the zone and control airflow between inside and
outside.

An additional socket is the "VASchedule" socket
which allows for the specification of a venting avail-
ability schedule for the component.

The "Control type" option sets the criteria for the
opening and closing of the component. ’None’ means
the windows doors are always closed, ’Zone’ means
they open/close according to the ventilation control
of the parent ’EnVi Zone’ node, “Constant” sets open-
ing/closing according to the schedule attached to the
“VASchedule” socket and "Temperature" sets open-
ing/closing based on a temperature thermostat schedule attached to the exposed “TSPSchedule”
socket.

Options in this node include:

◦ Type - the type of flow component

� Simple opening - simple controllable opening

* Win/Door OF - the maximum level of opening of this window/door

* Control type:
· Zone level - control is set be the options in the attached EnVi Zone node
· None - no control is applied
· Constant - window/door is constantly open
· Temperature - temperature control for this specific opening (exposes a TSPSched-

ule input socket to set a temperature schedule)

Component options - sets the specifics of the flow component:

* Closed FC - flow coefficient when the window/door is closed

* Closed FE - flow exponent when the window/door is closed

* Density diff - minimum density difference for two way flow (kg/m3)

* DC - discharge coefficient

� Detailed opening - detailed controllable opening

* Win/Door OF - the maximum level of opening of this window/door

* Control type:
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· Zone level - control is set be the options in the attached EnVi Zone node
· None - no control is applied
· Constant - window/door is constantly open
· Temperature - temperature control for this specific opening (exposes a TSPSched-

ule input socket to set a temperature schedule)

Component options - sets the specifics of the flow component:

* Closed FC - flow coefficient when the window/door is closed

* Closed FE - flow exponent when the window/door is closed

* Opening type:
· NonPivoted - side opening window/door
· HPivoted - horizontal pivoting window/door

* Crack length -extra crack length or height of pivoting axis

* OF Number - sets the number of opening factors. For each opening factor (up to a
maximum of 4) the following options are presented:

* OF - opening factor

* DC - discharge coefficient for opening factor

* Width OF - width factor for opening factor

* Height OF - height factor for opening factor

* Start height OF- start height of the opening factor

� Horizontal opening - horizontal controllable opening

* Control type:
· Zone level - control is set be the options in the attached EnVi Zone node
· None - no control is applied
· Constant - window/door is constantly open
· Temperature - temperature control for this specific opening (exposes a TSPSched-

ule input socket to set a temperature schedule)

Component options - sets the specifics of the flow component:

* Closed FC - flow coefficient when the window/door is closed

* Closed FE - flow exponent when the window/door is closed

* Slope - opening angle relative to horizontal (90 is fully open)

* DC - discharge coefficient

� ELA - uncontrollable effective leakage area aperture

* ELA (m^2) - area in m2

* DC - discharge coefficient

* PA diff - reference pressure difference (Pa)

* FE - flow exponent

� Crack - uncontrollable crack aperture

* Coefficient - flow coefficient

* Exponent - flow exponent
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4.15.11 The EnVi External node

Figure 44: EnVi External node

The EnVi External node can be added from the ’Add
> Airflow Nodes > External air’ menu and provides
wind pressure coefficients for the outside surfaces of
the building. These nodes are only required if the
"WPC type" option in the EnVi AFN node is set to
"Input". The node has sub-surface flow and a sur-
face flow sockets as both inputs and outputs. Joining
these sockets to a flow component specifies the build-
ing wind pressure coefficients for the angles specified
by an Azimuth Array node. An Azimuth Array node is
therefore required to be connected to the EnVi AFN
Control node for these nodes to be valid.

Options within this node are:

◦ WPC source:

� Manual - manual user entry of up to 12
wind pressure coefficients. These values
should correspond with the azimuth angles
entered into the Aximuth Array node.

� CSV - wind pressure coefficients are read
from CSV file

* Select - file opening dialogue to select
the CSV file

* Probe - the name of the probe location
to load WPCs for

* Azimuth and WPC values are shown within
the node
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4.16 EnVi Material Nodes

Version 0.6 of the VI-Suite has moved to using nodes to specify building constructions for EnergyPlus.
This allows the maximum number of EnergyPlus layers (10) to be specified and allows shading ele-
ments to also be simulated. For each Blender material that represents an Energyplus construction
the “Create EnVi Nodes” button must be pressed in the “VI-Suite Material” tab in Blender’s material
properties panel. When this button is pressed a node tree is created in the ’EnVi Material’ node editor
with the name of the material. Material node trees can be selected with the drop-down menu in the
middle of the header bar of the “EnVi Materials” The node tree corresponding to the currently selected
material should be displayed with a single “EnVi Construction” node.

4.16.1 EnVi Construction node

The EnVi Construction node is the fundamental node for EnergyPlus construction specification and
can be used on its own to specify a construction from the VI-Suite’s internal database, or in combin-
ation with layer nodes to define bespoke layers. Although this node is created automatically on the
generation of an EnVi Material node tree, additional construction nodes can be added via the ’Add >
Type Node > Construction Node’ menu item in an EnVi Material node tree. A basic construction node
is shown in figure 45. This node has one input socket called “PV” for the specification of PV modules,
and an optional input socket called “Outer layer” if a layer based construction specification is selected.

Figure 45: EnVi Construction node

Options within this node include:

◦ Active - this construction node and and
any linked layer nodes are the ones that
define the EnergyPlus construction. This
allows the quick switching between differ-
ent construction setups.

◦ Type - this sets the class of construction
type, which can be:

� Wall - opaque wall construction

� Floor - floor constructions that define
the zone floor area

� Roof - roof constructions

� Window - openable transparent con-
struction

� Door - openable opaque construction

� Shading - shading surface

� None - ignore this material

◦ Boundary - this sets the boundary on the other side of the construction, which can be:

� External - the conditions on the other side are ambient conditions (or ground in the case of
a floor)

� Zone - the conditions on the other side is another zone’s conditions

� Thermal mass - if the type is wall, floor or roof, heat flow through the construction is ignored
and is purely a source of thermal mass for the associated zone.

◦ Airflow - this sets whether the surface allows air to flow through it as part of a ventilation network
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◦ Proxy - sets whether this is a proxy construction

� Base - this construction is not a proxy

� Copy - this construction is a copy of another construction

* Base material - sets the construction to copy

� Reverse - this construction is a reversed copy of another construction

* Base material - sets the construction to reverse copy

◦ Specification - specifies how the construction is to be made up

� Pre-set - for the whole construction to be pulled from the current database

* This presents a drop-down menu to specify the database entry to be used:
· the thicknesses of each layer (mm) can then be set (numbers in brackets next to the

database entry label are sane numbers but the user can deviate from this)

* A U-Value calculation will be presented at the bottom

� Layers - to be made up of individual material layers. This exposes an input socket for the
connection of EnVi Layer nodes to make up the construction and presents the following
options:

* UV Calc - button to calculate the U-Value of the attached material layers (only valid for
opaque constructions)

* EC Calc - button to calculate the embodied carbon per unit area of the attached mater-
ial layers

* Name - text entry field to set the name of this construction. If text is entered the follow-
ing option is presented:

· Save - saves this construction make-up to the current construction database

4.16.2 EnVi Opaque Layer node

EnVi Opaque Layer nodes are added via the ’Add > Layer node > Opaque layer’ menu entry. The first
of these nodes attach to the “Outer layer” socket of the EnVi Construction node and subsequent layer
nodes can then be attached to the “Layer” input socket of previous opaque layer node. Only opaque
layer nodes can attach to opaque layer nodes.

Options with the opaque layer node are:

◦ Type - sets the type of material.

◦ Specification - sets whether the the material properties are pulled from the internal database or
defined with custom properties.

� If the specification is “Database” the following options are presented:

* Material - the database material.

* Thickness - of the layer (mm).

� If the specification is “Custom” the following options are presented:

* Name - sets the name of the custom material

* Conductivity - thermal conductivity (W/m.K)

* Thickness - thickness of the layer (mm)

* Roughness - surface roughness of the material

* Density - density of the material (kg/m3)

* SHC - specific heat capacity (j/kg)

* Therm absorb - infrared radiation absorptance

* Solar absorb - solar radiation absorptance
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* Vis absorb - visible radiation absorptance

* Layer Save - if a custom name has been specified a save button is presented to save the
material to the internal database.

Figure 46: EnVi opaque layer node (18mm
plaster board with embodied carbon)

Options are also presented to define the embodied
carbon of the layer:

◦ Embodied - a toggle to turn on embodied car-
bon calculation which presents the following
options:

◦ Embodied class - selects the class of material

� If set to a non-custom material class the
following options are presented:

* Embodied type - sets the type or sub-
class of the material

* Embodied material - sets the actual
material

* Service life - sets the service life of the
material (years)

* A list of the stored database values as-
sociated with the material are presen-
ted. These include:

· ecdu - embodied carbon per de-
clared unit

· eckg - embodied carbon per kg
· ec/m2 - embodied carbon per m2

of surface area
· ec/m2/y - embodied carbon per

m2 of surface area per year of its
service life

◦ If set to Custom then the following options are
presented:

� Embodied id - text entry filed to set a
unique id for the new database entry

* Embodied class - text entry field to set the material class

* Embodied type - text entry field to set the material type

* Embodied name - text entry field to set the material name

* Embodied modules - text entry field to set the embodied modules covered by this entry

* Embodied unit - drop down menu to specify the type of declared unit

* Embodied amount - numerical entry field set the amount of the declared unit con-
sidered

* GWP per amount - Global Warming Potential per the declared amount

* Embodied density - density of the material (an accurate value is only required if the
declared unit is m3 or kg)

* Service life - sets the useful service life of the material in years i.e. the number of years
before the material needs to be replaced.

* Save - a button to save the material to the embodied carbon database (assumes all the
above options have valid entries)
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4.16.3 EnVi Transparent Layer node

Figure 47: EnVi transparent layer (3mm
glass)

This node is similar to the above EnVi Opaque layer node
but details layers for glazing elements. This node can con-
nect, via its “Layer” output socket, to the “Outer layer” in-
put socket of a EnVi Construction node if the EnVi Con-
struction node has the “Window” type, or to the “Layer”
input socket of an EnVi Gas layer node to form multi-
layer constructions. Only EnVi Gas layer nodes can con-
nect to the “Layer” input socket. An input and output
“Shade” socket is also provided for the connection of shad-
ing nodes.

Options presented within this node are:

◦ Specification - sets whether the the material proper-
ties are pulled from the internal database or defined
with custom properties.

� If the specification is “Database” the following
options are presented:

* Material - the database material.

* Thickness - in mm.

� If the specification is “Custom” the following op-
tions are presented:

* Name - sets the name of the custom mater-
ial

* Conductivity - thermal conductivity (W/m.K)

* Thickness - thickness of the layer (mm)

* STN - solar normal transmittance

* FSN/BSN - front/back-side solar normal re-
flectance

* VTN - visible normal transmittance

* FVRN/BVRN - front/back-side visible normal
reflectance

* ITN - infra-red normal transmittance

* FIE/BIE - front/back-side infra-red emissiv-
ity

* Diffuse - whether this is a translucent rather
than a transparent element

* Layer Save - if a custom name has been spe-
cified a save button is presented to save the
material to the internal database.

◦ Embodied - toggle to turn on embodied carbon cal-
culation

� Options presented here are the same as for the EnVi Opaque layer node

4.16.4 EnVi Gas Layer node.
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Figure 48: EnVi Gas layer node

The EnVi Gas Layer node can be added with the “Add
> Layer Node > Gas layer” menu and creates gas layers
between the glazing layers of transparent constructions
and as such the “Layer” input and output sockets can only,
and both must, connect to EnVi Transparent Layer nodes.
The node has a “Specification” option where database or
custom can be chosen:

◦ Database - gas characteristics are read from the cur-
rent material database

� Air - air characteristics

� Argon - argon gas characteristics

� Krypton - krypton gas characteristics

� Xenon - xenon gas characteristics

� Thickness - thickness of the gas layer (mm)

◦ Custom

� Thickness - thickness of the gas layer (mm)

� Coeff A - conductivity coefficient A (W/m.K)

� Coeff B - conductivity coefficient B (W/m.K2)

� Coeff C - conductivity coefficient C (W/m.K3)

� Viscosity A - viscosity coefficient A (kg/m.s)

� Viscosity B - viscosity coefficient A (kg/m.s.K2)

� Viscosity C - viscosity coefficient A (kg/m.s.K3)

� SHC A - specific heat capacity coefficient A

� SHC B - specific heat capacity coefficient B

� SHC C - specific heat capacity coefficient C

� Mol Weight - molar weight

� SHR - specific heat ratio
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4.16.5 EnVi Shade node

Figure 49: EnVi Shade node

The EnVi Shade node can be added with the “Add >
Shading Node > Shading layer” menu and is designed
to introduce shading layers into layered, glazed con-
structions. The type of shading layer represented by
this node can only be used once for a particular ma-
terial and must connect via its input “Shade” socket
to the output “Shade” socket of the outermost EnVi
Transparent layer node, or to the input “Shade” socket
of the innermost EnVi Transparent Layer. The node
also contains a “Shade” input socket for connection
to the “Shade” output socket of a EnVi Shade Control
node.

Options in this node are:

◦ Solar trans. - solar transmittance

◦ Solar reflec. - solar reflection

◦ Vis. trans. - visible transmittance

◦ Vis. reflec. - visible reflectance

◦ IHE - infra-red hemispherical emissivity

◦ Intra. trans. - infra-red transmittance

◦ Thickness - shade thickness (mm)

◦ Conductivity - shade thermal conductivity (W/m.K)

◦ Glass distance - distance to glass layer (mm)

◦ Top mult. - top side opening multiplier

◦ Bottom mult. - bottom side opening multiplier

◦ Left mult. - left side opening multiplier

◦ Right mult. - right side opening multiplier

◦ Air perm. - air flow permeability
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4.16.6 EnVi Blind node

Figure 50: EnVi Blind node

The EnVi Blind node can be added with the “Add
> Shading Node > Blind layer” menu and integ-
rates shading blinds into glazing constructions.
The blind can be placed externally, internally or
between glazing layers but only one is permit-
ted per construction. The node has an output
and input “Shade” socket for connection to an
EnVi Transparent layer node “Shade” socket. The
node also has a “Control” input socket for con-
nection to a “Shade” output socket of an EnVi
Shade Control node.

Options in this node are:

◦ Slat orient. - slat orientation

� Horizontal - horizontal slats

� Vertical - vertical slats

◦ Slat width - width of the slats (this must be
less than the gas layer width if the blind sits
between glass layers)

◦ Slat sep. - separation between slats (this
mush be at least equal to slat width)

◦ Slat angle - angle of the slats (degrees)

◦ Slat cond. - thermal conductivity of the
slats (W/m.K)

◦ Slat beam trans. - slat beam transmission

◦ Front/Back beam reflec. - front/back-side
beam reflection

◦ Slat diff. trans. - slat diffuse transmission

◦ Front/Back diff. reflec. - front/back-side
diffuse reflectance

◦ Slat beam vis. trans. - slat beam visible
transmission

◦ Front/Back beam vis. reflec. - front/back-
side beam visible reflectance

◦ Slat diff. vis. reflec. - slat diffuse visible reflectance

◦ Front/Back diff. vis. reflec. - front/back-side diffuse visible reflectance

◦ Infra. trans. - infra-red transmission

◦ Front/Back infra. emiss. - front/back-side infra-red emissivity

◦ Glass dist. - distance between slat and window

◦ Top mult. - top side opening multiplier
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◦ Bottom mult. - bottom side opening multiplie

◦ Left mult. - left side opening multiplier

◦ Right mult. - right side opening multiplier

◦ Min ang. - minimum slat angle

◦ Max ang. - maximum slat angle

4.16.7 EnVi Screen node

Figure 51: EnVi Screen node

The EnVi Screen layer node can be added with
the “Add > Shading Nodes > Screen layer” menu
and can integrate an external shading screen
into layered, glazing constructions. This node
has an input “Shade” socket for connection to
the output “Shade” socket of the outermost EnVi
Transparency layer node (the connected to an
EnVi Construction node). The node also has an
input “Control” socket for connection to the out-
put “Control” socket of an EnVi Shade Control
node.

This node has the following options:

◦ Reflected beam - sets the algorithm for re-
flected beam solar:

� ModelAsDiffuse -

� ModelAsDirectBeam -

� DoNotModel -

◦ Diffuse reflectance - diffuse solar reflect-
ance

◦ Visible reflectance - diffuse visible reflect-
ance

◦ Thermal emissivity - thermal hemispherical
emissivity

◦ Conductivity - thermal conductivity

◦ Material spacing - screen material spacing (m)

◦ Material diameter - screen material diameter (m)

◦ Distance - screen to glass distance (m)

◦ Top mult. - top opening multiplier

◦ Bottom mult. - bottom opening multiplier

◦ Left mult. - left opening multiplier

◦ Right mult. - right opening multiplier

◦ Resolution angle - angle of resolution for output map
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4.16.8 EnVi Switchable node

Figure 52: EnVi Screen node

This node represents a switchable glass layer that con-
nects to the input “Shade” socket of EnVi Transparent
layer nodes via its output “Shade” socket. This node
has the same options as EnVi Transparent layer nodes
- with the exception of embodied properties which
are not provided - and represents glass layer proper-
ties that will replace the glass layer properties of the
connected transparent layer node when the schedule
mandates. The node has one “Control” input socket
for the connection of an EnVi Shade Control node to
specify the schedule.

4.16.9 EnVi Shade Control node

Figure 53: EnVi Shade Control node

This node specifies the schedule for shading nodes,
and has one “Control” output socket for connection
to the “Control” input socket of a shading node. Par-
ticular options within this node will also expose in
input “Schedule” socket. This node creates an En-
ergyPlus “WindowShadingControl” entity, and fur-
ther details on node options can be found in the relev-
ant section of the EnergyPlus Input Output reference
document. Options in this node are:

◦ Shading schedule - sets the type of schedule:

� Many options are available. Some will require a schedule node and a “Schedule” input
socket is exposed for connection to an EnVi Schedule node when required.

� Some will require one or two set-points and options for these set-points are exposed.

4.16.10 EnVi PV node

Figure 54: EnVi PV node

EnVi can now model the power output from
PV panels. The EnergyPlus simple, one-
diode and Sandia representations of PV char-
acteristics are all supported. PVs are spe-
cified with the EnVi PV node, which can
be added via the “Add > PV Node > PV”
menu entry. The node has one “PV” out-
put socket which should be attached to the
“PV” input socket of an EnVi Construction
node. The node also exposes input sock-
ets: “PV Generator” which must be connec-
ted to a PV Generator node (section 4.16.11)
and a “PV Schedule” which optionally should
be connected to a schedule node (boolean
type).

Options within this node include:

◦ Area - and auto calculation of the building
surface area with this PV material applied
(available after EnVi context export).
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◦ Heat transfer - sets the thermal relationship between the panel and any construction with which
it is associated

� Decoupled - the PV panel has no thermal relationship

� (see EnergyPlus InputOutput reference manual for more details).

◦ Type - Simple, One-diode and Sandia PV power algorithms (see EnergyPlus Input Output refer-
ence document for more details).

◦ If the simple type is selected options are:

� Proportion of the surface areas covered with actual PV cells.

� The conversion efficiency of the PV cells.

◦ If the One-diode type is chosen:

� Model - the database PV module model can be selected here or a custom module saved by
specifying the relevant parameters (see EnergyPlus InputOutput reference manual for more
details).

◦ If the Sandia type is chosen then simple set the PV module model.

PV installations can either be incorporated into wall and roof constructions, or they can be stand-
alone. For the latter case the PV material is applied to a shading material.

4.16.11 EnVi PV Generator node

An EnVi PV Generator node is required to take the power from PV modules and make them available to
the building as standard AC voltage by the use of an inverter. This node plugs into the “PV Generator”
input socket of a “PV” node. At this time only a simple inverter model is implemented and so options
here are:

◦ Efficiency - percentage efficiency of the inverter in converting DC from the PV panels to AC.

◦ Radiative fraction - the proportion of the power loss in conversion that is emitted as infrared
radiation by the inverter unit.

4.16.12 EnVi Schedule node

The EnVi Schedule node can be used to control when and in what proportion the PV panels and/or PV
generator produces power. If no node is specified it is assumed the PV system can produce power at
any time. The schedule node presents options in a similar manner to a general “EnVi Schedule” node
with 0 as off, 1 as on or a value in between for a proportion.

4.16.13 Copying materials

If you want to copy an existing EnVi material to change some of its properties, a particular process
should be followed. Create a new material slot for the object you wish to have the copied material.
Select in this slot the material you want to copy. Press the button immediately to the right on the
material name window, which will usually have a number displayed within it. This will create a copy
of the material. Rename this material how you wish and then recreate the material node tree by hitting
the ’Create EnVi Nodes’ button in the ’VI-Suite Material’ tab of the material.
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4.17 FloVi Nodes

FloVi nodes control the stages of a CFD simulation with OpenFOAM.

4.17.1 FloVi Case node

The FloVi Case node can be added with the ’Add > Process nodes > FloVi Case’ menu and creates
the directory structure and some of the high-level files required for an OpenFOAM simulation. The
directory structure is created within the “Openfoam/frame” directory in the project directory, where
frame is the Blender frame being simulated. This directory is known, in OpenFOAM terms, as the case
folder, which means OpenFOAM binaries run from within this folder will find all the information they
need to run the simulation.

Figure 55: FloVi Case node

The node contains one “Case out” socket for con-
nection to a FloVi Netgen node “Case in” socket and
contains the following context sensitive options:

◦ Scenario - this sets a general simulation context
which can filter the choice of available bound-
ary conditions:

� External flow - focused on wind-driven
flow around buildings

� Internal flow - focused on flow within
buildings

� Forced convection - focused on forced
flows with temperature simulation

� Free convection - focused on free convect-
ive flows

� Custom - all OpenFOAM boundary condi-
tions made available by the VI-Suite can be
used

◦ Parametric - sets a parametric analysis:

� Frames - start and end frame for a parametric analysis

◦ Time step - the false time step for a steady-state simulation (seconds)

◦ End time - the end false time for a steady-state simulation (seconds)

◦ Write interval - the false time step interval for the writing out of results

◦ Buoyancy - whether heat transfer is to be modelled (only presented if scenario is “Custom”,
“Forced convection” or “Free convection” and is mandatory for the latter two)

� Comfort - whether to calculate PPD and PMV comfort metrics

* Clothing - clothing level in clo

* Metabolic - metabolic rate in met

* Humidity - relative humidity in %

� Age - whether to calculate age of air

� Radiation - whether to include radiation calculations

* Rad model - sets the radiation model
· P1 - uses a p1 radiation model
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· fvDOM - uses a fvDOM radiation model

* Field radiation - sets the initial field radiation value

* Field I - sets the initial field I value for the fvDOM radiation model

� Field p_rgh - initial field p_rgh value

� Field alphat - initial field alphat value

◦ Field pressure - initial pressure within the domain

◦ Reference pressure - if a reference pressure value is required this sets the type:

� None - no reference pressure point is provided

� Relative - a relative pressure point is provided

* Ref. pressure value - relative pressure value in Pascals

* Pressure point - list of Blender empties that provide the location of the reference pres-
sure location

� Absolute - an absolute pressure point is provided

* Ref. pressure value - absolute pressure value in Pascals

* Pressure point - list of Blender empties that provide the location of the reference pres-
sure location

◦ Field velocity type - the initial domain velocity type:

� Vector - set an XYZ vector for flow direction

* X, Y & Z flow vector components (m/s)

� Azimuth - set an azimuth (degrees clockwise from +Y North) and speed (m/s)

* Field flow azi. - azimuth angle (degree)

* Field flow speed - flow speed (m/s)

◦ Field k - initial domain k value (number in brackets represents a suggested value based on field
velocity)

◦ Filed epsilon - initial domain epsilon value (number in brackets represents a suggested value
based on field velocity)

◦ Field nut - initial domain nut value

◦ p Residual - terminating pressure residual

◦ U Residual - terminating velocity residual

◦ k/epsilon Residual - terminating k and epsilon residual

FloVI Case node should be exported once the geometry and general material specification has been
created. The node should also be re-exported if any changes are made to sensing probes, a material
name or a boundary condition changes class e.g. from Patch to Wall.

4.17.2 FloVi Netgen node
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Figure 56: FloVi Netgen node

The FloVi Netgen node can be added with the ’Add
> Process nodes > FloVi Netgen’ menu and con-
trols computational mesh generation with Netgen
(https://ngsolve.org/). Netgen produces tetrahed-
ral meshes which can be converted in polyhedral
meshes with OpenFOAM. This node has one input
socket “Case in” for connection to a “FloVi Case” “case
out” socket and one output socket “Mesh out” for
connection to a “FloVi Boundary” “Mesh in” socket.
Upon pressing “Generate” the mesh will be construc-
ted and, all being well, a visualising mesh will be
created in Blender in the “FloVi Geometry” collec-
tion.

Options within this node include:

◦ Cell size - this sets the maximum cell size for the
overall domain

◦ Position corr - this sets the maximum distance
difference for a Blender face material to be asso-
ciated with a computational mesh face (this may need to be lowered if dealing with a very small
domain)

◦ Angular corr - this sets the maximum angular difference for a Blender face material to be associ-
ated with a computational mesh face

◦ Distinction angle - this sets the angle between geometry faces that will force Netgen to consider
the separating edge a mesh boundary

◦ Inflation - controls the rate at which smaller localised cells take on the size of the domain (smaller
value leads to a more gradual cell size change)

◦ Optimisations - controls the number of optimisations steps for the meshing algorithm

◦ Attempts - sets the number of attempts

◦ Polygonal - controls whether OpenFOAM should be used to generate a polygonal mesh

The node should be re-exported if changes are made to the simulation geometry, a material name or
material class specification is changed e.g. Patch to Wall.

4.17.3 FloVi Boundary node

Figure 57: FloVi Boundary node

Thie “FloVi Boundary” node can be added with the “Add > Pro-
cess nodes” menu and takes the FloVi boundary parameters set
within Blender’s Material properties panel and writes out the re-
quisite OpenFOAM boundary specifications. The node contains
one input “Mesh in” socket for connection to the “Mesh out”
socket of a “FloVi Netgen” node, and one output “Context out”
socket for connection to the “Context in” socket of a “FloVi Sim-
ulation” node. Upon pressing the “Generate” button boundary
specifications will be written to the case directory.

The node should be re-exported if any material name or spe-
cific boundary condition options change.
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4.17.4 FloVi Simulation node

Figure 58: FloVi Simulation node

The “FloVi Simulation” node can be added with the ’Add > Sim-
ulation nodes > FloVi Simulation’ menu and runs the Open-
FOAM simulation. The node contains one input “Context
in” socket for connection to a FloVi Boundary node “Con-
text out” socket, and one output “Results out” socket for con-
nection to a VI Metrics or VI CSV node. Probes will need
to be set-up within the flow domain for results to be avail-
able.

Options here are:

◦ Processes - splits the mesh into the set number of chunks
for parallel computation (this can be ultimately slower on
OS X and Windows as OpenFOAM is run from a Docker image)

◦ Paraview - opens Paraview for results visualisation (linux
only)

4.18 AuVi Nodes

AuVi nodes conduct acoustic analyses using the pyroomacoustics Python libraries.

4.18.1 AuVi Simulate

Figure 59: AuVi Simulation node

The AuVi Simulate node computes impulse re-
sponses based on room geometry, material ab-
sorption and scatter coefficients. This node is
available in the ’Add > Simulation nodes > AuVi
Simulation’ menu in the VI-Suite node tree.

The node contains two output sockets: ’IR’
which can export calculated impulse responses
for convolution and ’VI Results’ which exports
impulse response data for visualisation.

Options within this node include:

◦ Animated - uses Blender’s animation sys-
tem for parametric analysis.

� Frames - start and end frame of the
parametric analysis

◦ Max order - maximum number of im-
ages for the image based calculation step
(higher value increases simulation time,
especially with lots of room surfaces, but
may improve accuracy).

◦ RT rays - number of rays to be sent for the ray scattering calculation phase (higher value increases
simulation time but may improve accuracy).

◦ Receiver radius - radius of the sensor surface around calculation points (higher value decreases
simulation time but reduces accuracy).

Further information on the above options can be found in the pyroomacoustics documentation (ht-
tps://pyroomacoustics.readthedocs.io/en/pypi-release/index.html)
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4.18.2 AuVi Convolve

Figure 60: AuVi Convolve node

The AuVi Convolve node takes impulse re-
sponses from the AuVi Simulation node, and
convolves a user selected anechoic WAV file for
playback to get audio feedback as to how the
simulated space would sound. This node can be
added with the ’Add > Output nodes > AuVi Con-
volve’ menu entry. The node contains an input
socket ’IR’, which accepts an ’IR’ output socket
connection from an ’AuVi Simulation’ node.

This node has the following options:

◦ WAV select - this button opens up a file se-
lection dialog to select an anechoic audio
sample in wav format.

� Play - once a wav file has been selec-
ted this button will play the selected
wav file

◦ IR - this selects the impulse response from the AUVi Simulation node (these IRs are named frame
- name of blender listener object - name of Blender source object)

◦ Convolve - this button will convolve the selected wav file with the selected impulse response.

� Play - once a convolution has been done, this button will play the convolved audio.

� Save - this will open a file dialog to save the convolved wav file.
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5 Using the VI-Suite

The following section detail some of the analyses that can be done with the VI-Suite.

5.1 Sun Path Projection

Figure 61: Sun Path node set-up

Projecting a sun-path analysis into the Blender
scene requires a “VI Location” node to be cre-
ated to provide the latitude and longitude co-
ordinates of the scene. The “VI Location”
node can either take the latitude and longit-
ude values from an EPW file, or they can be
entered manually. Once the location node has been set-up a “VI Sun Path” node can be created and
the "Location out" socket of the location node dragged to the "Location in" socket of the “VI Sun Path”
node. A typical node set-up is shown in figure 61.

Figure 62: Sun Path visualisation options

The Sun Path node itself has one menu option to set the
number of suns created, and a button to be clicked to cre-
ate the sun-path. The created sun path with have a Blender
object base and Blender lights to represent the suns along
with OpenGL overlays of the sun paths. The entire sun
path references the base, which as a regular Blender ob-
ject (called spathMesh) can be rotated, scaled and moved,
and doing this will manipulate the entire sun path. The sun
path base object spathMesh has materials associated with
it and these can be changed to alter the appearance of the
sun path. Once a sun-path has been created a number of
options are presented with the 3D view port sidebar in the
"VI-Suite Display" tab (section 4.10.3). The sun path dis-
play options available are shown in figure 62.

The options in this panel are:

◦ Lighting - sets the way Blender’s solid view mode is lit.
Flat is recommended for sun path shadowing (solid
mode shadowing is turned on in the solid mode shad-
ing menu).

◦ Latitude - allows the changing of the latitude location
for the sun path

◦ Longitude - allows the changing of the longitude loc-
ation for the sun path

◦ Day of year - if a single or hourly sun set has been
created this option sets the day of the year for the sun
position(s)

◦ Time of day - if a single or monthly sun set has been
created this option sets the time of day for the sun
position(s)

◦ Sun strength - in solid shading mode, if shadows are turned on, this options sets the depth of the
shadows. If in Cycles rendered mode this sets the strength of the sun(s). This option is useful to
get the right level of shadows.

◦ Sun angle - in Cycles rendered mode this sets the sharpness of the shadows.
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◦ Line width - sets the width of the sun path lines (does not work on OS X).

◦ Solstice colour - sets the colour of the solstice lines.

◦ Hour main colour - sets the main colour fr the hour lines.

◦ Hour dash colour - sets the dash colour of the hour lines.

◦ Hour dash ratio - sets the size of the hour line dashes.

◦ Hour dash density - sets the ratio of dash to hour line.

◦ Sun size - sets the size of the OpenGL sun overlay.

◦ Sun colour - sets the colour of the OpenGL sun overlay.

◦ Globe colour - sets the colour of the sun path sphere.

◦ Display time - displays the date, time, solar azimuth and altitude next to the sun if a single sun
has been created.

◦ Display hours - displays the time in hours at the top and bottom of the hour lines.

◦ Font size - size of the font of any numerical/text display.

◦ Font colour - main font colour.

◦ Font shadow - turns on font shadowing.

◦ Shadow colour - changes the colour of the font shadow colour.

◦ Display active - turn this off to deactivate visualisation (this should be turned off when finished
with the visualisation).

For the sun path analysis the choice of suns requires certain rendering modes for optimal operation.
If a single sun is chosen then shadowing analysis can be achieved with the solid viewpoint render-
ing mode. If multiple suns are selected then shadowing can only be visualised in view port render-
ing mode, preferably with the Cycles rendering engine. In rendered mode, parameters such as sun
strength and sky colour are important to achieve the right balance of light and shadow.

5.2 Wind Rose Projection

Figure 63: Wind Rose node set-up

Projecting a wind rose into the scene requires a “VI Location” node and a “VI Wind Rose” node, that
latter of which can be added with the “Add > Analysis Nodes” menu.
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Figure 64: Histogram and contour wind roses

In this case the location node provides wind
speed and direction data for the wind rose ana-
lysis and therefore an EPW file must be chosen
as the source of information within the location
node. A typical node set-up is shown in figure 63.

The options within the wind rose node con-
trol the type of wind rose plot to create (two
types of histogram and three types of contour
plot are available), the start and end days of the
year to plot and the colour scale to use for the
plot. Examples of a histogram and contour plot
are shown in figure 64.

Figure 65: Wind metric display options

Once the button to create a wind rose is
pressed a wind rose object is created at the
centre of the scene. This object, like any Blender
object, can be moved, scaled and re-sized as de-
sired. Each time the wind rose button is pressed
a new object is created.

When a wind rose object has been created
a “Wind Metric” button is exposed in the "VI-
Suite Display" tab (section 4.10.3) of the 3D view
properties panel. Once this button is pressed 2
icons will appear in the 3D view: A "Legend" icon
to display the wind speed legend for the wind
rose, a “Table” icon to display tabulated wind
speed and direction data. The data displayed in
the table is extracted from the currently selected
wind rose object.

The scatter graph options present in version 0.6 have been replaced by the VI Heatmap node.

5.3 Shadow Mapping

Figure 66: Shadow Map node set-up

A shadow map study requires a VI Location node
to provide just the latitude and longitude co-
ordinates of the site, so either an EPW file or
manual entry can supply this data, and a VI
Shadow Map node. A typical node set-up is
shown in figure 66.

A shadow study analysis requires geometry
to act as shadowers, and sensing geometry to
measure the level of shadow. Blender mesh geo-
metry will by default act as a shadower and re-
quires no particular setting to do so as long as it
is visible in the 3D viewport. Sensing geometry
is specified via its material designation. Once a
Blender object has a material associated with it
(and this material can only be associated with
specific faces of an object if desired) then in the
Blender material properties panel in the VI-Suite
Material sub-panel there is an drop-down menu called "Material type". Within this menu the option
"Light sensor" should be selected. It should be noted that sensor geometry senses in the direction of
the normals of the geometry. You can check normal direction in Blender’s mesh edit mode. If nor-
mals point in the wrong direction “flip” the normals, or rotate the object so they face in the desired
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direction.
The year period for the simulation is set within the VI Shadow Map node with the start month and

end month options. The period of each day to be simulated is set with the start hour and end hour
options. The "Hour steps" option sets the hourly time step for the simulation. A value of 1 will do a
calculation once per hour, and a value of 4 will do 4 per hour. The "Animation" option allows either a
static analysis or one based on a geometry animation. If "Static" is selected then results are valid for
the current selected frame. If "Animated" is selected results will be generated for each frame of the
created animation.

Once a simulation has been completed, some simulation metrics will be written to the vi-suite-
log file and in the 3D viewport sidebar (section 4.10.3) the VI-Suite Display sub-panel will present a
shadow study display button. Once this is pressed results will be plotted on the sensing geometry with
a user defined colouration, signifying how often that point receives direct sunlight, when the sun is
above the horizon, for the specified simulation period. The display panel options are shown in figure
67. In the 3D viewport, an icon will be displayed in the upper left corner. Clicking on this will open up
a legend display relating colour to numerical value.

Figure 67: Shadow study display options

The options in the display panel are:

◦ VI 3D Display - If selected before the display
button is pressed the results can be extruded to
provide 3D result visualisation.

◦ Shadow Display button - When clicked will ini-
tiate display and expose further display options.

◦ Result type - sets the metric (% sunlit is the only
relevant metric here)

◦ Legend unit - a string entry box to replace the
legend unit title

◦ Processing - modifies the results or their visual-
isation

� None - no modification

� Modifier - a constant result modifier

� Script - a Python scripted result and/or
visualisation modifier

◦ Modifier - if modifier was selected in the previ-
ous option this string entry box can scale modify
the results (*100 would multiply results by 100,
/100 would divide by 100)

◦ Script - If script was chosen as the processing
option than a selection box is presented to pick
a Blender text file containing the python script.

◦ Frame - Either shows the frame that a static analysis was conducted on, or allows the picking of
the frame of a parametric analysis

◦ Legend max - allows the changing on the max value of the legend scale.

◦ Legend min - allows the changing of the min value of the legend scale.

◦ Legend scale - sets the legend scale to linear or logarithmic.
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◦ Legend colour - sets the colour of the legend and geometry colouration.

◦ Legend levels - sets the number of colour divisions of the legend and geometry colouration.

◦ Emitter materials - makes the Blender materials ignore any lighting (useful for Cycles rendered
mode).

◦ Emitter strength - emission strength of emitter materials

◦ Draw wire - draws a wireframe over the selected result visualisation geometry

◦ 3D Level - If “VI 3D Display” was selected this number will extrude the results plane for 3D results
visualisation.

◦ Transparency - sets the transparency of the result geometry

In the Point Visualisation section:

◦ Enable - Turns on per-point numerical visualisation of the results

◦ Selected only - Only the currently selected object will display numerical results

◦ Visible only - Only points not obscured in the 3D view show numerical results

◦ Font size, font colour, font shadow - changes the colour and size of the point numeric font.

Some additional metrics can be viewable by the use of the Modifier and Legend unit options. For
example, after simulation in the vi-suite-log file will be written the total number of hours over the
simulated period where the sun was above the horizon.

The node contains one output “Results out” socket which can connect to a VI Chart, VI CSV or VI
Heatmap node for data visualisation/export. Figure 68 shows a shadow study analysis of the terrain
around Mount Snowdon.

Figure 68: Shadow study analysis of Mount Snowdon

5.4 Sky View Factor

A sky view factor (SVF) analysis requires only a “VI SVF” node available in the “Add > Analysis Nodes”
menu. The node is described in section 21. The process of setting up the simulation is very similar to
the shadow mapping process in that Blender geometry with a “Light Sensor” material associated with
it will act as the sensing geometry according to the sub-divisions of the geometry. Once the “Sky View
Factor” button in the “VI SVF” node has been pressed the calculation will proceed and when finished
a “Sky View Display” button will appear in the “VI-Suite” tab of the 3D viewport sidebar. Pressing this
will create visualisation geometry in the “LiVi Results” collection and present options similar to those
described in the shadow mapping section(5.3). The “Results out” socket of the “VI SVF” node can be
connected to the “VI CSV” or “VI Chart” node for export/visualisation.
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5.5 Embodied Carbon Analysis

This section covers the stand-alone calculation of Embodied Carbon with the VI Embodied Carbon
node (section 4.12.5). In this stand-alone analysis, the volume or area of Blender mesh objects is con-
verted into an embodied carbon figure based on the embodied carbon data associated with the object.
This process therefore requires two things: Blender objects and embodied carbon data associated with
these objects.

In terms of objects, it is important that the objects modelled are appropriate for the embodied
carbon calculation. If the embodied carbon data associated object has a declared unit of m3, or kg
then the object must represent a coherent volume, and ideally be manifold i.e. all edges have two
faces associated with them and normals are consistent. A plane therefore would for example not be
acceptable. If the declared unit is m2, then it is the area of all the faces of the object’s mesh that will be
used in the embodied carbon calculation. If the declared unit is “Unit” then one object is assumed to
be one unit, irrespective of mesh characteristics.

Figure 69: VI-Suite Embodied carbon
object properties

The next thing that is required is appropriate embod-
ied carbon data associated with the objects. This is done
within the VI-Suite Object sub-panel in Blender’s Object
properties panel. By toggling on the ’Embodied’ option,
further options will appear (figure 69) to either call up the
the data from the current database, or to specify a new data
entry based on a manufacturer’s EPD file.

Options for calling up a database entry are:

◦ Embodied class - the class of material.

◦ Embodied type - the sub-class of material.

◦ Embodied material - the actual material.

◦ Service life - the expected service life before replace-
ment in years.

When a database entry has been selected, some informa-
tion about that database entry is also presented to the user:

◦ id - unique identifier for the entry

◦ quantity - amount of the declared unit considered

◦ unit - type of declared unit

◦ density - density of the material (kg/m3)

◦ weight - the weight of the quantity of the declared
unit

◦ ecdu - embodied carbon (kgCO2e) per declared
quantity

◦ eckg - embodied carbon (kgCO2e) per kg of material

◦ modules - the embodied carbon modules covered by
the declaration

A database entry can be edited by pressing the “Edit” button at the bottom. This will present dialogue
boxes showing the current materials characteristics. These can be changed and the “Save” button
used to update the database entry if the “Embodied id” option is not changed. If it is changed, a
new material is created. It is only recommended to edit entries the user has previously added, as the
database that comes with the VI-Suite is based on the ICE database.
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Figure 70: Embodied carbon pie chart

If “Custom” is chosen for Embodied class op-
tion, then entries are again editable. If the “Em-
bodied id” option is changed a new material will
be created. If not the current id entry will be up-
dated.

Once objects and their embodied carbon
characteristics have been set an embodied car-
bon calculation can be done using the VI Em-
bodied Carbon node (section 4.12.5). Create this
node select appropriate options, and press the
“Calculate” button. Upon completion results are
written to the node which can be accessed via
the VI CSV node and VI Metrics node.

The VI Metrics node type should be set to
“Embodied carbon” and will display embodied
carbon metrics for the chosen object/collection
for the chosen frame and will present a “Pie
chart” button to display a pie chart (figure 70) of the embodied carbon results (please not that ob-
jects or collections with a negative embodied carbon will not display in the pie chart).

If an animated simulation was conducted frame based results can also be visualised with the VI
Chart node.

5.6 LiVi Lighting Analysis

Lighting analysis is conducted with the LiVi component of the VI-Suite, which acts as a pre/post pro-
cessor for the Radiance software simulation suite.

The main LiVi nodes are: LiVi Geometry (section 4.13.1), LiVi Context (section 4.13.2), LiVi Sim-
ulation (section 4.13.3), LiVi Image (section 4.13.4), LiVi Glare (section 4.13.5) and LiVi FC (section
4.13.6). All are detailed in section 4.13. A basic LiVi analysis will require VI Location, LiVi Geometry,
LiVi Context and LiVi Simulation nodes.

A numerical LiVi lighting analysis, like a shadow study, requires geometry within the scene to be
identified as sensing geometry. This is done in the material panel within the Vi-Suite Material sub-
panel where the option "Light Sensor" should be selected in the "Material type" drop-down list. All
geometry to which this material is associated will now act as a sensing surface. Sensing surfaces are
not required for glare studies, image production or if only a preview of the Radiance scene is to be
conducted. The sensing geometry senses in the direction of the Blender mesh face or vertex normals.

5.6.1 LiVi Geometry

The LiVi Geometry node (section 4.13.1), which can be found in the "Add > Process Nodes" menu of
the Vi-Suite Nodes editor, controls the export of the of the Blender scene geometry and materiality to
the Radiance text file format. Any Blender geometry that is not hidden, and has materials associated
with Radiance material descriptions, will be exported unless the object or material has a “/” in the
name. Radiance material specifications are set in the VI-Suite Material properties sub-panel, details
of which can be found in section 4.10.2.

Upon pressing the node’s "Export" button the node first converts Blender materials to Radiance
material descriptions. Next, suitable geometry is exported. If the ’Mesh’ option in the LiVi Geometry
node is selected, then obj files are saved to the "obj" folder created in the project directory and auto-
matically converted to Radiance mesh files, with Radiance’s obj2mesh program. This is required for
Radiance patterns and textures (see below) to be applied. If the “Mesh” option is not selected, actual
object vertex co-ordinates are instead written out to the Radiance input and is generally a bit quicker
when simulating.

Next Blender lights are exported to Radiance format. There are two ways to set-up lights for Ra-
diance export: creating standard Blender lamps, or creating a plane at each face of which a lamp is
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automatically specified by giving the mesh the “Light Array” type in the VI-Suite Object sub-panel. If
using the first method then selecting a lamp within Blender will display in the VI-Suite Object sub-
panel some IES specific options. In this section it is possible to specify an IES file to associate with the
Blender lamp. IES files are released by luminaire and lamp manufacturers, and describe the bright-
ness of a luminaire or lamp from multiple directions. The desired IES can be picked with the "Select
IES File" button. Some additional options are also presented:

◦ IES Dimension - specifies the distance unit for the geometry described in the file

◦ IES Strength - which allows the light to be dimmed (can be animated)

◦ IES Colour - sets the colour of the lamp (can also be animated).

� RGB - sets the RGB colour of the lamp

� Temperature - sets the colour temperature of the lamp

The second method allows any selected mesh object to have an IES file associated with it via the VI-
Suite Object sub-panel by selecting “Light Array” as the object type. Any IES file selected here will now
be applied in the Radiance scene at each face centre of the mesh object. This is useful for quickly set-
ting up arrays of lights. Simple rotations of the light array object will be reflected in the positioning and
direction of the lights in the Radiance scene, although more complex rotations may not be correctly
reported to Radiance. In general keep IES object rotations to a single axis rotation.

If undertaking an animated, parametric analysis LiVi will export Radiance geometry and material-
ity for each frame from start frame to end frame as specified within the LiVi Geometry node interface.
How to set up animations in Blender is beyond the scope of this document so please refer to on-line
information for this but in short pressing the ’i’ key with the cursor over the value in the interface to
be animated will register that value for the current animation frame selected.

Radiance Patterns & Textures For certain Radiance material types there is also a “Texture image”
option available in the VI-Suite Material sub-panel. This allows the application of an image already
loaded into Blender to the geometry as a Radiance pattern. To apply the Radiance pattern the “Mesh”
export option must be turned on in the LiVi Geometry node. The image will also have to be UV
Mapped to the Blender geometry in Blender’s UV Editor to provide the positional relationship between
the image and the geometry. As the image acts as a modifier to the base Radiance material, the base
material should have a white colour to apply an unmodified image within a Radiance simulation.

(a) Texture map (Radiance pattern) (b) Normal map (Radiance texture) (c) Blend map (texture with white back-
ground)

Figure 71: Radiance image based materials

Radiance textures can be also be applied - assuming no blend map (see below) has been selected -
based on the Blender image selected in the “Normal map” option in the VI-Suite Material sub-panel.
If the material has a texture image that has already been UV mapped to Blender’s geometry this image
does not need to be UV mapped. Additional options are also exposed for the directions in Blender
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world co-ordinates of the colours within the normal map image when applied to the planar surface in
Blender, and the strength of the normal perturbation effect. These options mean that each material
texture map only works correctly for surfaces with the same orientation.

Blend maps can also be applied to the material if a normal map has not been applied. This Blender
image should be a black and white image where the white pixels will expose the current material, and
black will either be the background material selected below, or transparent if no background material
is selected. This image should be UV mapped to Blender geometry if no other image has already been
UV mapped.

For either patterns or textures to work when producing Radiance images with the LiVi Image node,
the “Illuminance” option within that node should be turned off.

Figure 72: Blender Particle Properties panel

Radiance Instancing Radiance instances can be im-
plemented by using Blender’s particle system. In-
stances allow many complex objects to be positioned
within the scene in a memory efficient way, and by
using Blender’s particle system, the positioning, rota-
tion and size of these objects can be randomised. This
can be useful when, for example, creating a forest with
a single tree model.

To create instances a mesh object is required as a
substrate for the instances e.g. a ground plane, and
another mesh object is required to be instanced e.g. a
tree. The instance object should have Radiance ma-
terials associated with it. A Blender particle system
should be created on the substrate object using the
Particle Properties panel (figure 72). Within this panel
The “Hair” option should be selected and the “Ad-
vanced” toggle selected. In the “Emission” sub-panel
the “Number” option sets the overall number of in-
stances available., and “Hair length” will scale the size
of the instances. In The “Source” section, the “Emit
from” option sets whether instances are associated
with the faces or the vertices of the substrate geo-
metry. If “Face” is selected then if “Distribution” is set
to “jittered” then the number of instance objects per
face can be set with the “Instance/Face” option. The
“Emission > Number” option should then be set to
the number of faces multiplied by the “Particles/Face”
option. If “Vertices” is selected in the “Emit from” op-
tion option the “Emission > Number” option should
be set to the number of vertices if one instance per
vertex is required.

By activating the “Rotation” sub-panel, the axis
of rotation can be set the “Orientation Axis” option,
which should be set to “Global Z” on the level of ro-
tation and randomness of the rotation can be set with
the “Phase” and “Phase” randomness options.

In the “Render” sub-panel select “Object” in the
“Render As” option and set the “Scale”, which is mul-
tiplied with “Hair length”, to generate an overall in-
stance size and “Scale Randomness” to randomise
size. In the “Object” section select the instance object
in the “Instance Object” options and turn on “Global
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Coordinates”, “Object Rotation” and “Object Scale”.

Radiance BSDFs It is possible to generate BSDFs with Radiance for use with simulation in the VI-
Suite. BSDFs are useful when considering the repeating arrays of geometry that constitute a complex
fenestration system (CFS) and a BSDF can be generated for one element of the repeating array.

To generate a BSDF a Blender object is required that represents the geometry for which a BSDF
is to be calculated. This object should have Radiance material properties associated with it, and the
object itself should be identified as “Complex Fenestration” in the Blender object properties panel in
the VI-Suite Object sub-panel. The size and position of the object does not matter as the VI-Suite does
not currently support the inclusion of geometry into the BSDF, and the VI-Suite automatically moves
and rotates the geometry to be suitable for BSDF generation. Other rules on generating BSDFs with
Radiance should however still be respected (see the genBSDF manual for details).

The object requires one mesh face that has the BSDF Radiance material specification. This face
is not part of the BSDF calculation itself, and can be created by copying an existing mesh face of the
object, but it does serve two other functions: it is the material associated with this face within which
the BSDF data will be stored, and the normal of the face must point into the room or towards the
camera ray direction. The face should also be positioned inline with the internal face of the object.

Figure 73: Example BSDF visualisation

Options for the BSDF material applied include:

◦ Proxy depth - not used during BSDF generation
but important for the application of the BSDF
material in a simulation.

◦ Up vector - this sets the up in Blender world co-
ordinates direction for the BSDF during genera-
tion and application

◦ Load BSDF - an existing BSDF file can be loaded
into this material

◦ Delete BSDF - a BSDF description associated
with this material is removed

◦ Save BSDF - saves the associated BSDF descrip-
tion to file

Once the setting for the BSDF material are as required,
and the in the Blender object properties panel the
object has been set to “Complex Fenestration”, more
options should appear for actual BSDF generation.
These include:

◦ Direction - sets the direction for the sample rays:

� backwards - from camera ray direction

� forwards - to camera ray direction

� bi-directional - both to and from camera ray
direction

◦ Klems/Tensor - whether a Klems or Tensor Tree BSDF should be generated

� Klems - standard BSDF sub-division (only this kind can be visualised within the VI-Suite)

� Symmetric - Tensor standard sub-division

� Asymmetric - advanced asymmetric Tensor sub-division
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◦ Samples - number of samples per direction

◦ RC params - text box for custom rcontrib parameters

Once these settings are as desired the “Generate BSDF” button can be clicked and the BSDF will be
created. A Kivy window will pop up although this window cannot give a prediction of time remaining
for BSDF calculations. Pressing the “Cancel” button will kill BSDF generation if the Python psutil pack-
age is available. If not, rcontrib processes must be killed manually. Bear in mind that BSDF generation
with high sample numbers can take a long time.

Once completed, the BSDF information is stored within the Blender material, and can now be
applied to Blender geometry for simulation. Any geometry that is to have the BSDF applied must have
it’s normal also pointing inwards, or towards the camera ray direction.

The “Proxy Depth” of the material can now be used. If the proxy depth is zero, all incoming light
will be processed via the BSDF. If the proxy depth is more than zero any valid Radiance geometry
within that depth will deal with direct light calculation and the BSDF with diffuse. This can be done
using Blender instances for memory efficiency. If no geometry is specified direct light will pass straight
through the BSDF. The “Up Vector” should also be set to the up direction of the geometry to which the
BSDF material is applied.

If a Klems BSDF has been generated, the BSDF can be visualised with the VI-Suite. Selecting the
original complex fenestration object, and selecting the BSDF material within that object, should dis-
play a “BSDF Display” button in the VI Display section of the VI-Suite tab in the 3D view port sidebar.
Clicking this button will create an icon in the upper left of the 3D view port. Clicking on this will dis-
play two Klems distributions: the upper one can be clicked on to select the incoming light direction
and the bottom one displays the outgoing light percentage distribution. Options are also displayed in
the VI-Suite display tab that include:

◦ Direction - sets the direction for visualisation

◦ BSDF max/min - sets the legend maximum and minimum values

◦ BSDF scale - linear or logarithmic legend scale

◦ BSDF colour - sets the legend and BSDF colouration

◦ Display active - this should be turned off after visualisation

5.6.2 LiVi Basic analysis

Figure 74: Typical LiVi Basic node set-up

A basic analysis allows for the prediction of illu-
minance (lux), irradiance (W/m2) and Daylight
Factor (%). A typical node set-up is shown in fig-
ure 74.

A VI Location (section 4.11.1) node, LiVi Geo-
metry (section 4.13.1) node, LiVi Context 4.13.2)
node and a LiVi Simulation (section 4.13.3) node
are required for this type of analysis and the
node connections should replicate the connec-
tions shown in figure 74. A basic LiVi analysis
can be selected in the first menu of the context
node.

If no sensing geometry is present only the
“Preview” button will appear in the LiVi Sim-
ulation node. Pressing the “Preview” button
will open up a Radiance rvu window to preview
the scene from the perspective of the chosen
Blender camera. A blender camera is therefore
required in the scene.
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If sensing geometry is present then pressing the "Calculate" button will run the Radiance simu-
lation. A Kivy window should then, assuming the simulation takes enough time, appear giving an
estimate of simulation time and presenting a button to cancel the simulation. When completed the
Radiance results are stored within the meshes of the sensing geometry for visualisation. After simu-
lation options in the "VI Display" panel detailed in section 5.6.7 control visualisation of these results
within the 3D viewport. The options within this panel are similar to the ones available for shadow
mapping (section 5.3).

Figure 75: LiVi viewport Daylight Factor visualisation

A “VI results” socket is also exposed for connection to a VI Chart, VI Heatmap, VI Metrics and
VI CSV node. VI Heatmap visualisation works best with LiVI CBDM analyses (section 5.6.3) and VI
Metrics nodes need to be set to “Lighting” to display daylight factor results and compliance with RIBA
and BREEAM daylighting requirements.

RIBA 2030 Climate Challenge - Daylighting

DF IR
Average Daylight Factor Illuminance Ratio

2.0 0.4

8.85 0.57
Sensor location: Plane

Figure 76: RIBA 2030 compliance info-graphic

In addition, for RIBA compliance, The VI
Metrics node will display an “Infographic” but-
ton, which will open a new window with the
compliance graphic (figure 76), and a vector file
called metric.svg will be created in the project
directory. This graphic compares average day-
light factor and illuminance ratio to the bench-
mark values (2.0 and 0.4 respectively). The name
of the sensing object, selected in the VI Metrics
menu, is shown at the bottom of the graphic.
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5.6.3 LiVi CBDM

Figure 77: LiVi CBDM node setup

A Climate Based Daylight Modelling (CBDM) analysis requires the same node setup as a basic LiVi ana-
lysis, but with the first option of the LiVi Context node set to “CBDM”. Some CBDM specific options
are then revealed in the context node (section 4.13.2). A CBDM analysis allows the lighting perform-
ance of a building over longer periods of time to be analysed. The other difference is that an EPW file
must be specified as the source of location information in the VI Location node as the information for
the environmental lighting conditions is provided (at least initially) by this EPW file. There are three
main types of analyses:

◦ Exposure - calculates the cumulative exposure of either illuminance (luxhour) or irradiance (kWh)

◦ Hourly irradiance - calculates the hourly irradiance (W/m2) at each sensor point, which is then
aggregated for a whole obtect to produce an hourly sum in kW, or an hourly average in kW/m2

landing on an object.

◦ DA/UDI/SDA/ASE - calculates hourly metrics such as daylight availability (DA), annual sunlight
exposure (ASE), useful daylight illuminance (UDI).

◦ Glare - calculates glare occurance/autonomy as an annual summary with optional hourly fig-
ures.

When the simulation node’s calculate button has been pressed the Radiance simulation is initialised,
a Kivy window will appear and the Blender interface will lock up until completion. The simulation
can however be cancelled from the Kivy window. If an hourly calculation metric has been selected the
simulation can take some time. Once completed, display options will again appear in the VI Display
sub-panel and detailed in section 5.6.7. A “Results out” output socket is also exposed in the simula-
tion node for connection to a visualisation node. If hourly data has been generated, the VI Chart, VI
Metrics and VI Heatmap node can be used for visualisation. The VI Metrics node can be used to test
for compliance against LEED v4 Option 1 daylighting criteria if a DA/UDI/SDA/ASE analysis has been
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undertaken. Set the metrics node type to “Lighting” and the metric to “LEED”. An “Infographic” will
also be exposed to generate an infographic in a new window. This vector image is also saved to the
project directory as metric.svg. Figure 78 shows an example. The VI CSV node can be used for further
results processing.

Figure 79: LiVi viewport UDI visualisation

5.6.4 LiVi Image creation

Figure 78: LEED v4 compliance info-graphic

Radiance images can be generated with LiVi for more
contextual illuminance/brightness calculations and
glare analysis. To create a Radiance image, the LiVi
Geometry and LiVi Context nodes connect into a LiVi
Image (section 4.13.4) node instead of a LiVi Simula-
tion node.

Once the desired options have been set in the LiVi
Image node then pressing the “Image” button will be-
gin the calculation of the image and bring up a Kivy
window to show progress. As the simulation runs the
image will be updated and stored to the “liviimage”
image in Blender’s image editor. It should be noted
that the generation of high accuracy Radiance images
can take a long time.

Especially when simulating exterior scenes, the
image produced can be over-exposed and appear too
white in Blender. In this case the Compositor window
in Blender can be used to tonemap the image.

Once the simulation is finished then the im-
ages are saved to the images folder in the project
directory with name(s) base_name-frame.hdr where
base_name is set in the image node and frame is the
frame for which the image is generated.
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Radiance images can be de-noised by Blender quite nicely (figure 80) and is detailed in this You-
Tube video (https://www.youtube.com/watch?v=JdP9Tx9nPgI).

(a) Base image (b) De-noised image

Figure 80: Blender de-noising of Radiance images

5.6.5 LiVi Glare analysis

Instantaneous glare analysis is achieved with the LiVi Glare (section 4.13.5) node, and uses the evalg-
lare program included with Radiance. Glare analysis requires a fisheye Radiance image of a scene, and
this image can be provided by the LiVi Image node. To generate this image the fisheye option should
be selected in the image node, 180o should be set as the field-of-view (fov) and image pixels should
be set to 800x800. Larger images can be processed but it takes a long time. Once the image has been
generated the image node can be plugged into the LiVi Glare node. Appropriate options can then be
set in the glare node, and the “Glare” button pressed to start the glare calculation. The glare analysis
image will be saved in the “images” folder of the project directory with the name base_name-frame.hdr
where base_name is set within the node, and frame is the frame the image is generated for. The image
will contain on the top right a list of glare parameter such as daylight glare probability (DGP). Refer to
the evalglare manual for information on these parameters.

Figure 81: LiVi glare analysis (red areas show high glare probability)
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5.6.6 LiVi False Colour

Figure 82: LiVi falsecolour processing showing
scene brightness

A LiVi image can be processed with a false col-
our filter to associate colours, via a legend, with
the numerical data embedded within the image.
A false colour image is produced by connecting a
LiVi Image node to a LiVi False Colour node (sec-
tion 4.13.6) or by using the file open dialogue to
open an Radiance HDR formatted image. If the
image is generated with the LiVi image then seet-
ings within that node define what king of data
is embedded within the image. If the “Illumin-
ance” toggle is turned on then the image con-
tains illuminance data in lux. If not then the
image contains luminance data in cd/m2. Once
options in the LiVi False Colour node are set as
desired, then pressing the “Process” button will
create a false colour image in the “images” folder
of the project directory. The name of this file will
be base_name-frame.hdr where base_name is set
within the node, and frame is the frame of the simulation the original image is associated with.

5.6.7 LiVi Display

After a LiVi basic or CBDM simulation, display options are presented within the VI Display panel of
the VI-Suite tab of Blender’s viewport sidebar (toggled with the "n" key over the 3D display). A typical,
LiVi specific VI Display panel is shown in figure 83 along with the Blender viewport and result/legend
display.

Figure 83: LiVi Display options

Initially after simulation, only the "VI 3D display" toggle switch and the "Radiance Display" button
are shown. The "VI 3D display" toggle controls whether a 3D display of the results metric is desired.
Once the "Radiance Display" button is pressed new Blender objects will be created in the “LiVi Results”
collection and coloured according to the Radiance results., icons to display data graphics will appear
in the 3D view and further options are presented. If the colouration of the results geometry cannot be
seen, and you are in Blender’s solid display mode, you need to select material colour in the solid mode
shading menu at the top of the 3D viewport. The options presented include:
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◦ Result type - sets the metric for display. Choices here will depend on the kind of analysis that has
been conducted.

� A basic lux analysis will present entries for lux and visible irradiance (W/m2)

� A basic analysis with a Daylight Factor sky will present entries for Daylight Factor (%) and
visible irradiance (W/m2)

� A basic analysis with a Gendaylit based sky and with “Spectrum” set to “Full” will present
entries for full irradiance (W) and full irradiance per unit area (W/m2).

� A CBDM exposure analysis will present entries for cumulative solar irradiance (kWh) and
cumulative solar irradiance per unit area (kWh/m2) if “Spectrum” was set to “Full” in the
LiVi Context node. If “Spectrum” was set to “Visible”, kilo-lux hours, cumulative visible irra-
diance (kWh) and cumulative visible irradiance per unit area (kWh/m2) are available.

� A CBDM hourly irradiance presents cumulative solar irradiance (kWh) and cumulative solar
irradiance per unit area (kWh/m2) are available.

� A CBDM DA/UDI/ASE/SDA analysis will present DA, sDA, ASE, UDI (low, supplemental,
autonomous and high), lux (max, min and average) and perimeter area options.

� An annual glare anlysis will present values for glare occurance (GO (%)) and glare autonomy
(GA (%)).

◦ GA view - selects the view if an annual glare analysis has been conducted.

◦ Legend unit - string entry to replace the legend title unit.

◦ Processing - menu entry to define any modifiers to be applied to the results.

� Modifier - uses the following string entry to modify the results

* string entry to act as a result modifier (*100 would multiply results by 100, /100 would
divide by 100).

* this option in combination with the legend unit option can be used to display results
that are not embedded in the result geometry e.g. lux values can be extracted from
Daylight Factor (%) by placing *100 here.

� Script - uses a script to modify the results

* File - Blender text editor script for custom result modification (see appendices)

◦ Frame - frame selection to visualise a step in an animated/parametric simulation

◦ Legend max/min - controls the range of the displayed legend and the associated sensor mesh
colours in the 3D view.

◦ Legend scale - legend and result display can be set to linear or logarithmic.

◦ Legend colour - sets the colour map for the legend and sensor geometry.

◦ Legend levels - sets the number of legend and mesh colouration sub-divisions.

◦ Emitter materials - set the result colour materials to emitters (ignores shading in rendered mode)

� Emitter strength - sets the brightness of the emitter materials

◦ Draw wire - toggles the display of a wire-frame for the selected object. May need to be selected
twice to turn on the wire-frame.

◦ 3D Level - controls the level of 3D extrusion of the results geometry (only appears if VI 3D display
option was chosen)

◦ Transparency - set the transparency level of the result geometry
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The Point visualisation section controls the display of numerical result values for each point of the
sensing geometry. Options in this section include:

◦ Enable - toggles numeric display

◦ Selected only - display numerical results only on the underlying selected mesh faces

◦ Visible only - only the sensing geometry points not behind other geometry display numerical
values (orientating the view to the selected object may be required to correctly calculate which
points are visible)

◦ Font size, colour, shadow controls the number display

◦ Position offset - controls the offset point for the numerical display (in general should be set to
the same value as the offset value in the LiVi Geometry node

The "Display active" option at the bottom turns off result display. This should be turned off when
results display is no longer required.

5.7 EnVi Energy Analysis

Figure 84: Typical EnVi node set-up with VI Chart, VI Heatmap and VI Metrics visualisation nodes

The EnVi component of the VI-Suite is a pre-processor for the EnergyPlus simulation engine (ht-
tps://energyplus.net/). When Blender mesh objects are specified as EnVi surfaces, have materials as-
sociated with them that contain EnergyPlus construction details, via EnVi material nodes, and are or-
ganised into Blender collections to represent thermal zones, they can then be exported to EnergyPlus
for analysis. EneryPlus only accepts planar geometry, so zones can either be modelled in Blender
with planar surfaces or with more complex geometry but with only the mesh faces that would make
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Figure 87: EnVi material layer nodes

up the planar geometry given EnVi construction characteristics. Here we will look at a simple planar
geometry case.

Figure 85: EnVi collection organisa-
tion

First save the Blender file, if not already saved, as this will
define the project directory. One can then proceed to create
geometry with regular Blender mesh objects, bearing in mind
that +Y in Blender is North. The image in figure 86 shows a
simple planar model. Blender mesh objects that will define an
EnergyPlus thermal zone must all be placed in the same Blender
collection. In this example the Blender mesh object has all the
surfaces required for an EnergyPlus thermal zone so can go on
its own into a Blender collection. Both the collections and the
objects inside can be named for clarity. Here I will use “Studio”
for the name of the collection and Studio_model for the name of
the object (figure 85). Avoid spaces in the names of objects and collections. The object also needs to
be given the EnVi Surface designation in the VI-Suite Object properties panel.

Figure 86: Simple planar geometry model

Next we need material specifications. Create
and apply Blender materials to the faces of the
object’s mesh. In this simple example I will cre-
ate a “Walls” material for the walls, “Roof” for
the roof, “Floor” for the floor and “Window” for
the windows and associate them with the rel-
evant mesh faces. For each material click the
“Create EnVi Nodes” button in the VI-Suite Ma-
terial properties panel. This will create an EnVi
Material node tree associated with that material.
Within this node tree there will be a single EnVi
Construction node. Within this node set the type
of construction: “Walls”, “Floor” etc. as appro-
priate and choose whether construction details will be pulled up from the current database (pre-set
specification), or whether layer nodes will be used to build a custom construction (layer specification).
If using pre-set, select the database entry and fill in the required layer thicknesses. If using layers, add
a material layer node (sections 4.16.2, 4.16.3 and 4.16.4) and connect it to the “Outside layer” input
socket of the EnVi Construction node. This will be the outermost material layer. Add subsequent layer
nodes to each previous layer node to build up the construction, working inwards towards the inner
layer. EnergyPlus allows up to 10 layers. Figure 87 shows a layered wall construction with the inner
layer a custom defined.

Once the materials have been specified, go to the VI-Suite Nodes window and create a new node
tree with the button in the middle of the header bar. Add a VI Location node (section 4.11.1) and set
“Source” to EPW, then select either one of the included weather locations or, if a custom EPW weather
directory has been set in the VI-Suite addon preferences, a user supplied one.
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Figure 88: Post export geometry (original on the
left, offset copy on the right)

Add an EnVi Geometry (section 4.14.1) node
and set the offset option to move the exported
geometry away from the original for visibility.
Press the “Export” button and a copy of the ori-
ginal geometry will be created, offset by the set
amount. The materials will also be coloured ac-
cording to the type of material construction, as-
suming you are in Blender viewport solid ren-
dering mode. This helps identify any errors in
material allocation. If an error has been made,
simply correct and re-export. The colours as-
signed are brown for floor, green for roof, grey for
walls, turquoise for windows, yellow for party constructions, red for shading surfaces and blue for PV
panels. A new Blender collection will be created called “EnVi Geometry” and within this collection
will be collections that represent the thermal zones (figure 89) with “EN_” prepended to the original
collection names.

Figure 89: EnVi Geometry collection

Once geometry export is complete, an EnVi
Network node tree will be created and in this
node tree will be an EnVi AFN (section 4.15.1)
node, and an EnVi Zone (section 4.15.3) node for
each created collection. These nodes may also
be created on top of each other and will need to
be moved around for visibility.

It is important to check the volume of the
zone being reported in the EnVi Zone nodes,
as the automatic calculation can be incorrect
with non-manifold geometry. If it is wrong, se-
lect “Manual” and enter the correct volume. In
this example there is no airflow network so the
AFN node can be ignored. The EnVi HVAC, Oc-
cupancy, Infiltration and Equipment nodes can
now be used to define the heating, cooling, occupancy, infiltration and equipment gains. The example
in figure 90 shows heating applied with a thermostat level of 20oC and an occupancy level set with a
schedule of full occupancy of three people between 08:00 and 18:00 on weekdays and unoccupied at
other times.

Once each zone has been given the desired characteristics, the EnergyPlus input file can be written
with an EnVi Context node (section 4.14.2) added within the VI-Suite Nodes tree. This node should be
connected to both the VI Location node and to the EnVi Geometry node. In this node some general
characteristics of the project can be set, and the results to be calculated chosen. In this case “Zone
Thermal > Temperature”, “Zone Thermal > Heating” and “Comfort > Occupancy” are selected.

Once the context has been exported, an EnergyPlus simulation can be conducted with an EnVi
Simulation (section 4.14.3) node attached to the EnVi Context node. During simulation a Kivy window
will appear to monitor progress or cancel the simulation. Upon completion, a VI CSV node can be
connected to the simulation node to export results to CSV, or if visualisation of the results is required,
then a VI Heatmap, VI Chart, or VI Metrics node can be connected to the simulation node (figure 84).
A typical node layout is shown in figure 84.

It is also important for EnVi analysis to provide a database directory within the VI-Suite addon pref-
erences to store a custom database of EnergyPlus materials and constructions. The relevant database
files are the Material_database.json and Construction_database.json files respectively. If this direct-
ory is not set the user can still use and edit the built-in databases but these will be overwritten when
updating the VI-Suite.
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Figure 90: EnVi Zone specification

5.7.1 EnVi Embodied Carbon analysis

As well as energy analysis, EnVi can can conduct an embodied carbon analysis to deliver a whole-
life carbon (combining operational and embodied carbon) result that gives a better indication of the
overall environmental impact of a building.

The specification of the embodied carbon specification of building surfaces is done in the same
way as the specification of custom layer thermal properties: via the EnVi Material opaque and trans-
parent layer nodes (section 4.16.3 & 4.16.2). Each of these nodes has an “Embodied” toggle which
presents options to either read embodied carbon data from the current database or for the input of
embodied carbon data from a manufacturer’s Environmental Performance Declaration (EPD) associ-
ated with their product. It is beyond the scope of this document to detail all the features of embodied
carbon counting and EPDs, but a manufacturer’s EPD will contain some key information that EnVi
needs for an embodied carbon analysis. The most important of which is global warming potential
(GWP) in kgCO2e, which EnVi uses as the embodied carbon metric. This GWP can cover a range of
embodied carbon modules which identify the various steps of in the lifetime of a material. The ICE
database which comes with the VI-Suite considers embodied carbon over the modules A1 to A3, which
means from cradle to gate or from raw material extraction to leaving the factory. Generally EPDs will
always give a figure over A1 to A3. There are other modules that cover transportation to building site,
installation, maintenance and disposal and EPDs may or may not give GWP figures for these modules.
The user is free to use a GWP figures for any range of modules provided by an EPD, and the modules
covered can be added in to the EnVi nodes via a text box e.g. A1 - A3 or A1 - A5, B1 - B2.

The next piece of important information in the EPD is the declared unit i.e. the unit of measure for
the material for which a GWP number is produced. Common units are kg, m3, m2 or 1 of the product
concerned e.g. the embodied carbon value of a chair is generally per chair. This data can also be
entered into the node. As well as the declared unit there can be a declared amount i.e. how many
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of the declared unit is the GWP presented for. This is often one but there are cases where it is more
convenient to talk about, for example, the GWP for 2.5kg of material.

An often required piece of information is density. EPD files give a density in kg/m3where appro-
priate, and this can be useful as it can convert the volume based data of EnVi materials into a weight.
This is especially important if the declared unit is weight based e.g. kg.

The final piece of information needed from an EPD is the service life, or the life of the product in
years before on average it needs to be replaced.

In terms of Blender geometry, the nature of the embodied carbon data used has some consequences
on how things are modelled. When EnVi materials are created a thickness is specified and this material
is applied over the Blender mesh faces which constitute an area. This gives a volume. If the declared
unit is m3 then this is a simple conversion. If the declared unit is m2 then the thickness specification
is ignored, although it is still used for the thermal calculation. If the declared unit is kg, the density
figure inputted is required to convert the volume to a kg amount. If the declared unit is Unit then each
Blender mesh face that has this material applied should be the same area as would be represented by
the product unit when installed in the facade.

There may be elements of the overall building that are not part of the layering of the facade but
for which an embodied carbon calculation is desired. An example of this may be a frame structure of
the building, or some internal fittings/furniture. As these elements are not be part of a conventional
EnergyPlus thermal model, they can be treated differently. In this case they can be represented in 3D
and a process the same as that described in section 5.5 for a stand-alone embodied carbon analysis
can be followed. As long as these objects are included in an EnVi thermal zone Blender collection,
results will be included in the final EnVi results.

5.7.2 EnVi EMS calculations

A basic node setup to use EnergyPlus’ EMS system is shown in figure 91.
The EnergyPlus zone we are controlling is the EN_LIVING_ROOM zone. The sensor within that

zone is CO2, so CO2 should be calculated for that zone. The actuator is set to “Opening factor” which
will control the opening factor or any windows and doors in the zone. These two selections create
named actuator and sensor sockets in the “EMS Zone” node that must be connected to the EMS Pro-
gram node to be registered within EnVi. The socket names should replicated exactly in the program
text detailed below.

Figure 91: EnVi EMS node setup

An example Blender text file contents to control the node parameters setup is shown in code list-
ing 1. The contents should be pretty clear: If the internal CO2 within the EN_LIVING_ROOM zone is
above 1000 the opening factors of the win_EN_LIVING_ROOM_5 and win_EN_LIVING_ROOM_6 is set
to 1. If not the windows opening factors are set to closed. The syntax of this text should follow that
laid down in the EnergyPlus EMS documentation with the exception that the semi-colons at the end
of each line are not required.
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IF EN_LIVING_ROOM_CO2 > 1000
SET win_EN_LIVING_ROOM_5_of = 1
SET win_EN_LIVING_ROOM_6_of = 1
ELSE
SET win_EN_LIVING_ROOM_5_of = 0
SET win_EN_LIVING_ROOM_6_of = 0
ENDIF

Listing 1: Example ERL program listing

5.7.3 EnVi Display

3D viewport display of EnVi results is not currently supported in version 0.7.

5.7.4 Storing EnVi custom constructions and materials

In general it is recommended that custom materials are added to the builtin database via the buttons
in the “EnVi Construction” (section 4.16.1) and “EnVi Layer” nodes. Be aware that unless a custom
database directory is set within the VI-Suite addon settings, this database is overwritten if updating
the VI-Suite.

It is however possible to edit the databases directly. Within the VI-Suite add-on preferences data-
base directory are a number of json formatted files. EnVi constructions are stored in “Construc-
tion_database.json” and materials in the “Material_database.json” file. Before changing either of these
files it is a good idea to make a back-up copy. If editing this file then adding a new material will require
adding a material name and a list of properties to the correct material class. For example adding the
entry below to the “Metal” class would add a “Lead” material.

"Lead" : [ "Smooth" , " 35.3 " , " 11340 " , " 128.00 " , " 0.05 " , " 0.05 " , " 0.05 " , "5" ]

The first word is the name of the material, the first word within brackets is the surface roughness,
and the following numbers are thermal conductivity (W/m-K), density (kg/m3), specific heat (J/kg-K),
thermal absorbtance, solar absorbtance, visible absorptance, default thickness (mm).

A material added to the “Glass” class may look like

" Clear 6mm" : [ " Glazing " , " SpectralAverage " , " " , " 0 . 0 0 6 " , " 0 . 7 7 5 " , " 0 . 0 7 1 " ,
" 0 . 0 7 1 " , " 0 . 8 8 1 " , " 0 . 0 8 0 " , " 0 . 0 8 0 " , " 0 . 0 " , " 0 . 8 4 " , " 0 . 8 4 " , " 0 . 9 " ]

The numbers within the brackets specify default thickness (m), solar transmittance at normal in-
cidence, front side solar reflectance at normal incidence, back side solar reflectance at normal incid-
ence, visible transmittance at normal incidence, front side visible reflectance at normal incidence,
back side visible reflectance at normal incidence, IR transmittance at normal incidence, front side IR
hemispherical emissivity, back side IR hemispherical emissivity and thermal conductivity (W/m-K).

Any entry added to the json files should be comma separated from the existing entries in that class.

5.8 FloVi Flow Analysis

FloVi employs Netgen (https://ngsolve.org/) for mesh generation and OpenFOAM (https://openfoam.org/)
for simulation of fluid flows. On Linux, a native OpenFOAM installation is required. This can generally
be installed through the system’s package manager. Once installed, use the “OpenFOAM bin” option
in the VI-Suite addon preferences to point the VI-Suite to the “bin” directory within the OpenFoam
installation that contains the “foamExec” executable. Save the settings and then restart Blender.

On Windows and OS X, setting the “OpenFOAM bin” option is not necessary but an installation
of Docker Desktop (https://www.docker.com/products/docker-desktop/) is required, and within this
the dicehub/openfoam:11 OpenFOAM image should be installed. Docker must then be running in the
background while conducting FloVi analyses.

The sections below detail the steps that should be taken, in order, to undertake a flow analysis.
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5.8.1 Generating an OpenFOAM case directory

As all CFD analyses require an overall computational domain, the Blender scene must contain one
and only one object defined with the “CFD Domain” property in the VI-Suite Object properties panel
and visible within the 3D viewport. This is the domain that will encompass the entire fluid simulation.
This object can be any shape.

In addition, objects can sit within the fluid domain to act as obstructions to the fluid flow. These
geometries must sit fully and separately within the overall domain as overlapping geometries are not
supported. To identify these objects as obstructions select “CFD Geometry” in the VI-Suite Object
properties panel. Again, these objects can be any shape.

Finally, empties and mesh objects can be created to act as probes within the domain. These should
be positioned inside the domain, and outside any obstructions, and identified as a probe by selecting
’CFD Probe’ in the VI-Suite Object properties panel.

It is important that all domain and obstruction geometry is manifold i.e. a completely sealed and
coherent volume. There is a tool in Blender “Select non-manifold” to highlight object geometry that is
non-manifold for corrective purposes.

The domain and obstructions must also have Blender materials associated with each face, as it
is with these materials that we will designate the boundary conditions for the fluid flow simulation.
To begin, simply create and apply a different Blender material to every face of the domain, and any
internal geometry, that will have a distinct boundary condition e.g. a material for solid surfaces, inlets,
outlets, symmetries etc.

Once geometry has been created, and materials applied, then in a VI-Suite Nodes window create a
FloVi Case node from the “Add” menu. Details of this node can be found in section 4.17.1. In this node
the type of simulation, initial field conditions and whether heat (buoyancy) and radiation should be
simulated can be specified.

The important parameter in this node is the scenario setting, as this will define what kind of bound-
ary conditions are available for the materials applied to the geometry.

Upon clicking the “export” button at the bottom of the case node an OpenFOAM case folder is
created within the OpenFOAM directory of the project directory. The case directories are named after
the name of the frame(s) being simulated e.g. if a parametric simulation over frames 1 to 3 is exported
the case directories ’1’, ’2’ and ’3’ will be created in the project directory/OpenFOAM directory.

5.8.2 Specifying OpenFOAM boundary conditions

After a FloVi case has been generated, general boundary conditions for the material associated with
the mesh geometry can be specified. These specifications are still made in the material properties
panel of the relevant material but the details of this specification have changed since v0.6.

Now the boundary condition options provided are filtered by the scenario chosen in the FloVi case
node. Five scenarios are offered:

◦ External flow - predominantly for wind flow around buildings.

◦ Internal flow - predominantly for forced ventilation inside buildings.

◦ Forced convection - predominantly for forced ventilation inside buildings with temperature cal-
culation.

◦ Free convection - predominantly for buoyancy driven natural ventilation inside buildings.

◦ Custom - all boundary conditions available in the VI-Suite are available to the user and the con-
text of the simulation is up to the user.

At this stage it is only necessary to pick the desired boundary type e.g. if an external flow case has been
selected then the material associated with the mesh face where wind will leave the domain should be
set to Outlet. Boundary types for the different scenarios are listed below:

◦ External flow
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� Outlet - where the wind will leave

� Inlet - where wind will enter

� Sky - symmetry boundary

� Solid - solid wall boundary (ground/buildings)

◦ Internal flow

� Inlet - place where air will come in

� Outlet - place where air will go out

� Solid - solid wall boundary

◦ Forced Convection

� Velocity in - place where air comes in with a set velocity

� Pressure in - place where air comes in with a set pressure

� Velocity out - place where air leaves with a set velocity

� Pressure out - place where air leaves with a set pressure

� Solid - solid wall boundary

◦ Free Convection

� Inlet - place where air is expected to come in

� Outlet - place where air is expected to go out

� Solid - solid wall boundary

◦ Custom scenario

� All available boundaries - refer to OpenFOAM documentation for their meaning.

If the context option in the case node is changed and the case re-exported, it is important to re-check
the general boundary condition specification for each material.

5.8.3 Generating an OpenFOAM mesh

Figure 92: Polygonal mesh on a solid bound-
ary

The VI-Suite uses Netgen (https://ngsolve.org/) to
create a tetrahedral domain mesh with the “FloVi Net-
gen” node (section 4.17.2). This can then be op-
tionally converted into polygonal domain mesh with
OpenFOAM. The “Case in” socket of this node should
be connected to the “Case out” of a FloVi Case node.

Options within this node, control the internal
mesh maximum cell size and some advanced mesh-
ing parameters. Clicking the “Generate” button at the
bottom of the node generates a tetrahedral mesh. If
OpenFOAM is available on your system then a poly-
hedral mesh can be generated instead with the node’s
Polygonal option. The resulting mesh will be dis-
played in Blender via an object called “Mesh” created
in the “FloVi Mesh” collection. If there are any errors
in mesh generation, an error message will be added
to the “vi-suite-log” file in Blender’s text editor. After
mesh generation, re-export the FloVi case to register
the mesh.
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Options for visualising the mesh in Blender are limited but a simple visualisation of the mesh can
be conducted. One simple method is to alter Blender’s viewport starting clip plane. This will hide
geometry closer to the camera than the clip distance allowing a view inside the mesh. If you want to
see the mesh distribution on a boundary enter edit mode on the mesh and deselect all elements by
pressing “Alt a”. Go to the Material Properties panel and beneath the list of material associated with
the mesh you will see a select button. With the boundary material you wish to visualise selected press
this select button and then press “Crtl i” to invert this selection. Pressing “h” will now hide all mesh
elements that do not have that material. An example is shown in figure 92. Pressing “Alt h” will unhide
everything again.

More extensive mesh visualisation options are available with Paraview (https://www.paraview.org/).
After mesh creation, a frame.foam file is created within the project directory/OpenFOAM/frame dir-
ectory, where frame is the Blender frame being simulated. This foam file can be opened directly with
Paraview.

5.8.4 Generating OpenFOAM boundaries

Once the mesh has been generated, the detailed characteristics of the mesh boundary conditions can
now be written into the case directory. This is done with the FloVi Bound node (section 4.17.3), the
“Mesh in” input socket of which should be connected to the “Mesh out” socket of the FloVi Netgen
node. This node is useful to make changes to the detailed boundary characteristic without having to
generate a new mesh. An exception to this is if you want to change the general boundary class e.g.
from “Inlet” to “Solid”. This will require a new case export and a new mesh generation.

For example, if ’External flow’ was selected as the scenario in the “FloVi Case” node then the fol-
lowing boundary conditions are offered:

◦ Outlet

� pressure - totalPressure and fixedValue OpenFOAM boundaries are offered

� U - pressureInletOutletVelocity OpenFOAM boundary is offered

� nut - calculated OpenFOAM boundary is offered

� k - inletOutlet OpenFOAM boundary is offered

� epsilon - inletOut OpenFOAM boundary is offered

◦ Inlet

� pressure - zeroGradient OpenFOAM boundary is offered

� U - fixedValue and atmBoundaryLayerInletVelocity OpenFOAM boundaries are offered

� nut - calculated OpenFOAM boundary is offered

� k - fixedValue OpenFOAM is offered

� epsilon - FixedValue OpenFOAM boundary is offered

◦ Solid

� pressure - zeroGradient OpenFOAM boundary is offered

� U - noSlip OpenFOAM boundary is offered

� nut - nutlWallFunction OpenFOAM boundary is offered

� k - kqRWallFunction OpenFOAM boundary is offered

� epsilon - epsilonWallFunction OpenFOAM boundary is offered

◦ Sky

� a symmetry boundary and is generally used for the top of the domain or side faces parallel
to the flow direction.
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Choosing an “Internal flow” case presents similar boundary conditions:

◦ Inlet

� pressure - zeroGradient boundary is available

� U - fixedValue boundary is available

� nut - calculated boundary is avaialble

� k - fixedValue boundary is available

� epsilon - fixedValue boundary is available

◦ Outlet

� pressure - fixedValue and totalPressure boundaries are available

� U - pressureInletOutletVelocity boundary is available

� nut - calculated boundary is avaialble

� k - inletOutlet boundary is available

� epsilon - inletOutlet boundary is available

◦ Solid

� pressure - zeroGradient OpenFOAM boundary is offered

� U - noSlip OpenFOAM boundary is offered

� nut - nutlWallFunction OpenFOAM boundary is offered

� k - kqRWallFunction OpenFOAM boundary is offered

� epsilon - epsilonWallFunction OpenFOAM boundary is offered

Choosing an “Forced convection” case presents the following boundary classes:

◦ Velocity in (to be used in combination with a Pressure out boundary for outgoing flow

� pressure - calculated boundary is available

� U - fixedValaue boundary is available

� nut - calculated boundary is available

� k - turbulentIntensityKineticEnergyInlet boundary is available

� epsilon - turbulentMixingLengthDissipationRateInlet

� T - fixedValue is available

� p_rgh - fixedFluxPressure is available

� alphat - calculated boundary is available

� Rad - MarshakRadiation and zeroGradient boundaries are available

◦ Velocity out - to be used in combination with a Pressure in boundary for incoming flow

� pressure - calculated boundary is available

� U - fixedValue boundary is available

� nut - calculated boundary is available

� k - zeroGradient boundary is available

� epsilon - zeroGradient boundary is available

� T - zeroGradient boundary is available

� p_rgh - zeroGradient boundary is available
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� alphat - calculated boundary is available

� Rad - MarshakRadiation and zeroGradient boundaries are available

◦ Pressure in - to be used in combination with a Velocity out boundary for outgoing flow

� pressure - calculated boundary is available

� U - pressureInletOutletVelocity boundary is available

� nut - calculated boundary is available

� k - turbulentIntensityKineticEnergyInlet boundary is available

� epsilon - turbulentMixingLengthDissipationRateInlet

� T - fixedValue is available

� p_rgh - totalPressure is available

� alphat - calculated boundary is available

� Rad - MarshakRadiation and zeroGradient boundaries are available

◦ Pressure out - to be used in combination with a Velocity in boundary for incoming flow

� pressure - calculated boundary is available

� U - inletOutlet boundary is available

� nut - calculated boundary is available

� k - inletOutlet boundary is available

� epsilon - inletOutlet boundary is available

� T - zeroGradient boundary is available

� p_rgh - prghPressure boundary is available

� alphat - calculated boundary is available

� Rad - MarshakRadiation and zeroGradient boundaries are available

◦ Solid

� pressure - calculated boundary is available

� U - noSlip boundary is available

� nut - nutkWallFunction OpenFOAM boundary is available

� k - kqRWallFunction OpenFOAM boundary is available

� epsilon - epsilonWallFunction OpenFOAM boundary is available

� T - zeroGradient boundary is available

� p_rgh - fixedFluxPressure boundary is available

� alphat - compressible::alphatJayatillekeWallFunction boundary is available

� Rad - MarshakRadiation boundary is available

Choosing a “Free convection” case presents the following boundary classes:

◦ Inlet

� pressure - calculated boundary is available

� U - pressureInletOutletVelocity boundary is available

� nut - calculated boundary is available

� k - inletOutlet boundary is available

� epsilon - inletOutlet boundary is available
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� T - inletOutlet boundary is available

� p_rgh - totalPressure boundary is available

� alphat - inletOutlet boundary is available

� Rad - MarshakRadiation and zeroGradient boundaries are available

◦ Outlet

� pressure - calculated boundary is available

� U - inletOutlet boundary is available

� nut - calculated boundary is available

� k - inletOutlet boundary is available

� epsilon - inletOutlet boundary is available

� T - inletOutlet boundary is available

� p_rgh - inletOutlet boundary is available

� alphat - inletOutlet boundary is available

� Rad - MarshakRadiation and zeroGradient boundaries are available

◦ Solid

� pressure - calculated boundary is available

� U - noSlip boundary is available

� nut - nutkWallFunction OpenFOAM boundary is available

� k - kqRWallFunction OpenFOAM boundary is available

� epsilon - epsilonWallFunction OpenFOAM boundary is available

� T - zeroGradient boundary is available

� p_rgh - fixedFluxPressure boundary is available

� alphat - compressible::alphatJayatillekeWallFunction boundary is available

� Rad - MarshakRadiation boundary is available

Choosing a “Custom” case exposes all boundary conditions available in the VI-Suite and is for users
with knowledge of OpenFOAM and appropriate boundary conditions for a simulation.

Pressing the “Generate” button will create the boundary conditions according to the parameters
set for the mesh materials.

5.8.5 Simulating an OpenFOAM case

Figure 93: FloVi Kivy window

A FloVi Simulation node is required to conduct
an OpenFOAM simulation, the “Context in” in-
put socket of which should be connected to the
“Context output” socket of the “FloVi Boundary”
node. Pressing the “Calculate” button will initi-
ate the simulation and a Kivy window will appear
(figure 93) to monitor the progress of the simu-
lation by showing the timestep and result resid-
uals. A new Kivy window will appear for each
frame of the simulation. The “Cancel” button at
the bottom of the Kivy window can be used to
cancel the simulation.

After calculation, Paraview (https://www.paraview.org/) can be used to visualise results of the sim-
ulation. On all platforms a frame.foam (where frame is the frame number) file is created within every
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Figure 94: FloVi node setup

project directory/OpenFOAM/frame directory. This file can be opened directly in Paraview. In addi-
tion, on linux the Paraview option can be turned on within the node to automatically open Paraview
open completion of the simulation. Probe results are also written to the “Results out” socket for export
to CSV with the VI CSV node, graphing with the “VI Chart” node or summarising with the “VI Metrics”
node.

A complete node set-up is shown in figure 94.

5.8.6 Visualising OpenFOAM results

Most of the visualisation of OpenFOAM results is conducted with Paraview (https://www.paraview.org/).
It is beyond the scope of this document to detail a Paraview workflow, but it is possible to import back
into Blender the results of Paraview visualisations. By exporting the selected visualisation geometry
with the “File > Export Scene” menu in Paraview, and selecting the *.gltf format. This *.gltf file can then
be imported into Blender with the “File > Import > glTF 2.0” menu entry (the glTF import addon may
have to be activated first). The imported geometry may have to be rotated 90o on the x-axis to line up
with the original FloVi geometry.

It is also possible to use another Blender add-on for the visualisation of OpenFOAM results: BVTKNodes
(https://github.com/tkeskita/BVtkNodes). Although not production ready, BVTKNodes can visualise
OpenFOAM domain slices, streamlines and glyphs from within Blender and is under active develop-
ment so will get better over time.

The VI-Suite also offers limited native visualisation of OpenFOAM results. The FloVi Simulation
node can be connected to a VI Metrics node or a VI Chart node. Both will visualise the results at
probes specified within the domain: VI Chart will produce charts of variables over the simulation time
steps, and the VI Metrics node will display the final results at the probe locations. A VI CSV node can
be used to export probe values out to CSV file.

5.9 AuVi Acoustic Analysis

AuVi employs the pyroomacoustics (https://github.com/LCAV/pyroomacoustics) Python library to
calculate reverberation times and impulse responses within a modelled space. On Windows/OSX, py-
roomacoustics is installed by the VI-Suite on addon activation. On Linux, pyroomacoustics is included
with the download.
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The sections below detail the steps that should be taken, in order, to undertake an acoustic analysis.

5.9.1 Constructing a model

AuVi analyses are conducted on Blender geometry and materiality that constitute an acoustic space.
In terms of geometry, the space should be represented with a surface model i.e. only the interior

surfaces of the space are modelled, that fully encompasses the interior volume and is manifold. The
dimensions of this model should be in meters, and the normals of all the faces should point outwards.
The VI-Suite object type should be kept at the default (None). An example of such a model is shown in
figure 95.

Figure 95: AuVi model

To the faces of this model should be associated Blender materials with acoustic properties. This
is achieved through the material properties panel in the VI-Suite Material section. The two acoustic
parameters pyroomacoustics supports are: absorption coefficient or how much sound is absorbed;
scattering coefficient or to what extent rays are scattered and represents the roughness of a material
or the non-modelled geometric complexity of the surface.

Figure 96: AuVi material panel

Options within this panel include:

◦ Material type - to set the material type to
an AuVi material.

◦ AuVi absorption class

� Database - selects absorption coeffi-
cients from the material database

� Custom - allows for the input of ab-
sorption coefficients

* Flat response - if on, sets one ab-
sorption coefficient for all octave
bands. If off, an absorption coeffi-
cient for each octave band can be
set.

◦ AuVi scatter class

� Database - sets scattering coefficients from the material database
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� Custom - allows for the input of scattering coefficients

* Flat response - if on, sets one scattering coefficient for all octave bands. If off, a scatter-
ing coefficient for each octave band can be set.

Once a model geometry and materiality have been created, sources and listeners of sounds need to be
created.

5.9.2 Creating sources and listeners

In order to generate impulse responses and reverberation times at least one source of sound and one
listener of sound is required. These are created with Blender empties that are given the Source or
Listener property in the AuVi type menu in the VI-Suite Object panel when an empty is selected in the
3D viewport. These empties should be within the modelled space.

In addition, a sensing surface can be created to create an array of listeners. For the moment this
copies the process of setting a sensing surface within LiVi i.e. the Light sensor option is selected in the
Material type menu in the VI-Suite Material panel for the material associated with the sensing object.
A listener is created at the centre point of each face of the sensing object. Only one sensing object is
currently supported.

Once these steps have been completed, an impulse response and reverberation time simulation
can be conducted.

5.9.3 Generating impulse responses and reverberation times

For the simulation of impulse responses, an AuVi Simulation node is required. See section 59 for the
options within this node. Upon pressing the Generate IR button within this node a Kivy window will
open to allow cancellation of the simulation and the Blender interface will lock while the simulation
is running. High accuracy settings, especially higher max order (>3) settings with complex room geo-
metry can take a very long time. Start low and increment upwards is my advice. If the settings in the
simulation node do not lead to a valid reverberation time calculation the simulation will terminate
with an error message, which is also written to the vi-suite-log file in Blender’s text editor. Errors of
this kind are generally due to the settings not producing enough sampling data and increasing the the
RT rays value and/or the receiver radius values can remove the error.

5.9.4 Visualising results

Figure 97: AuVi node setup

Once an AuVi simulation has been completed, the output sockets of the AuVi Simulation node can be
connected to other nodes for further processing of the results data. For all microphones set via empty,
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the VI Results socket can be connected to a VI Chart node to plot impulse responses, or connected to
a VI CSV node to export impulse responses and reverberation times, or to a VI Metrics node to display
reverberation times. The IR socket can be connected to an AuVi Convolve node to convolve selected
anechoic sounds with the generated impulse responses. An example node setup is shown in figure 97.

In addition, if microphones were set via a sensing surface, the reverberation time results on this
surface can be visualised within the 3D Viewport with the Acoustics Display button in the VI-Suite
Display panel. Again, this currently copies the LiVi display process and result displaying surface will be
placed within a LiVi Results collection. An icon will also appear in the upper left corner of the viewport,
which when pressed will display a colour legend of reverberation times. An example visualisation is
shown in figure 98.

Figure 98: AuVi results in connected acoustic spaces

6 Known issues

◦ If using the potable zip version of Blender on linux, Netgen will not work. Either proceed without
FloVi functionality or install Blender, PyQt6, matplotlib, Kivy and Netgen with your system’s
package manager.

◦ If a VI Display is running when a different Blender file is loaded this can cause an error.

◦ If doing a parametric analysis over more than 70 frames the “VI-Chart” may seg fault Blender.
Use the “VI CSV” node to output a csv file and plot from there instead.

◦ If maximising an area window while the VI-Suite is displaying results in the 3D viewport an
error will occur and “internal error: modal gizmo-map handler has invalid area” will be prin-
ted to the system terminal. You will then need to deactivate the VI display and then reactiv-
ate. This is a known Blender bug and you can register your interest in getting it fixed at ht-
tps://developer.blender.org/T77419.

◦ If using shape keys to animate an object for a LiVi analysis then these shape keys will be lost if a
sensing surface is also part of the object.

◦ On OS X the Kivy window does not appear in front of the Blender window. Check the desktop for
this window when running a simulation.
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◦ If switching between analysis types it is recommended that the complete export process is re-
peated for the new analysis.
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Additional installation notes

On Arch linux an installation of libxcrypt-compat is required. If the VI-Suite activation gives an error
in the terminal about a missing libcrypt.so.1, install this package.

Additional FloVi results extraction

By default, FloVo only records volume flow rate through mesh objects specified as FloVi probes. The
example sampleDict file below, which should be placed in the “system” folder of the case directory, en-
ables the p and U sampling of stl surfaces. The stl file names in the file should point should correspond
to stl files in the “constant/triSurface” directory in the case directory.

/*−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−*− C++ −*−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−*\
| ========= | |
| \\ / F i e l d | OpenFOAM: The Open Source CFD Toolbox |
| \\ / O peration | Version : 2 . 1 . 0 |
| \\ / A nd | Web: www.OpenFOAM. org |
| \\/ M anipulat ion | |

\*−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−*/
FoamFile
{

vers ion 2 . 0 ;
format a s c i i ;
c l a s s d i c t i o n a r y ;
o b j e c t sampleDict ;

}
// * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * //
type s u r f a c e s ;
surfaceFormat raw ;
interpolationScheme c e l l ;
// F i e l d s to sample .
f i e l d s
(

p
U

) ;
s u r f a c e s
(

stl_name_1
{

// Sampling on t r i S u r f a c e
type triSurfaceMesh ;
s u r f a c e stl_name_1 . s t l ;
source c e l l s ;
i n t e r p o l a t e true ;

}
stl_name_2
{

// Sampling on t r i S u r f a c e
type triSurfaceMesh ;
s u r f a c e stl_name_2 . s t l ;
source c e l l s ; // sample c e l l s or boundaryFaces
i n t e r p o l a t e true ;

}
) ;
// * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * * //
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Custom Data Processing

For types of analyses that project results on to Blender meshes such as lighting metrics, shadow study
and SVF calculations it is possible to manipulate the results for presentation. There are two types
of manipulation: simple modifier and scripted manipulations. These options are controlled via the
’Processing’ menu in the VI-Suite Display panel. Options in this menu are: ’None’, ’Modifier’, and
’Script’. If ’Modifier’ is selected a text box will appear where a valid Python expression can be entered
e.g. /2 to divide all results by 2; *7 could be entered to multiply all results by 7; *2+9 could be entered
to multiply by 2 and add 9 etc.

An example of the use of this would be to convert shadow study data into the number of sunlit
hours. When a shadow study calculation is conducted the number of total hours, and the number of
hours that the sun was above the horizon, is displayed in the VI-Suite log file. Shadow study results
are by default the proportion of hours when the sun was above the horizon that a point received direct
sunshine. To display instead the number of total sunlit hours, enter *X into the text box where X is the
total number of hours when the sun was above the horizon. If the proportion of the total hours that
points were sunlit is desired then *X/Y could be entered where Y is the total number of hours.

If ’Script’ is selected in the ’Processing’ menu, a drop-down menu will appear to select a Blender
text file. This file should be opened or created in Blender’s text editor. This text file should define
functions in Python that manipulate the results: a ’resmod’ function, and/or change the legend text
entries: a ’restext’ function. This is advanced functionality and some knowledge of Python program-
ming is recommended as this file must contain valid Python code.

The ’resmod’ function takes a list of results (defined by the “Result type” option) from each of the
visualisation meshes, and returns a modified list of the same length and in the same order. The num-
bers returned should be integers and point to results material associated with the object: 0 would
point to the first material (lowest numerical band), 5 would point to the 6th material. It is therefore
important that no number is returned that is higher than the number of Legend Levels set minus 1.

The ’restext’ function returns a list of strings to be written into the legend that must have a length
one less than the number of Legend Levels set in the VI-Suite display tab. Although the scripting
method is very flexible it is especially good at visualising conditional results i.e. manipulating results
based on user-specified criteria. A simple example with comments is shown in code listing 2.

# Import the main Blender Python l i b r a r y
import bpy

# Define the resmod function that t a k e s a l i s t o f o r i g i n a l r e s u l t s
def resmod ( r e s l i s t ) :

# r e s l i s t i s a numpy array so we need to import numpy
import numpy
# Find the average o f the r e s l i s t s
ave_r = numpy . average ( r e s l i s t s )
# Create a new empty r e s u l t s l i s t
n e w r e s l i s t = [ ]

# I t e r a t e thought the o r i g i n a l r e s u l t s
f o r r in r e s l i s t :

# S e t a c o n d i t i o n a l statement ( uniformity r a t i o >= to 0 . 4 )
i f r / ave_r >= 0 . 4 :

# Add an index to the new r e s u l t s l i s t f o r t h i s condit ion
n e w r e s l i s t . append ( 1 )

# S e t a c o n d i t i o n a l statement ( uniformity l e s s than 0 . 4 )
e l s e :

# Add an index to the new r e s u l t s l i s t f o r t h i s condit ion
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n e w r e s l i s t . append ( 0 )

# Return the new r e s u l t s l i s t
return n e w r e s l i s t

def r e s t e x t ( ) :
# Return a l i s t o f s t r i n g s f o r the legend . Lowest value f i r s t .
# The length o f t h i s l i s t must be one l e s s than the Legend L e v e l s

s e t t i n g
return [ " 0 . 4 " ]

# This r e g i s t e r s the f u n c t i o n s within Blender ’ s d r i v e r namespace
bpy . app . driver_namespace [ ’ resmod ’ ] = resmod
bpy . app . driver_namespace [ ’ r e s t e x t ’ ] = r e s t e x t

Listing 2: Example results processing script

The above code listing would result in the following visualisation of illuminance uniformity ratio,
as required by the RIBA 2030 Climate Challenge.

Figure 99: Custom data visualisation of uniformity ratio
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